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Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product may only be 
used in accordance with the license agreement.

This product may be protected by one or more U.S. and non-U.S patents. Details are available at www.avid.com/patents.

The content of this guide is copyright protected guide and is made available for personal use.  It may not be reproduced or distributed, in 
whole or in part, without permission of Avid. Reasonable care has been taken in preparing this guide, however, it may contain omissions, 
technical inaccuracies, or typographical errors. Avid Technology, Inc. disclaims liability for all losses incurred through the use of this 
document. Product specifications are subject to change without notice.

Copyright © 2016 Avid Technology, Inc. and its licensors. All rights reserved.
This product includes FFmpeg, which is covered by the GNU Lesser General Public License.

This product includes software that is based in part of the work of the FreeType Team.

This software is based in part on the work of the Independent JPEG Group.

This product includes libjpeg-turbo, which is covered by the wxWindows Library License, Version 3.1.

Portions copyright 1994, 1995, 1996, 1997, 1998, 1999, 2000, 2001, 2002 by Cold Spring Harbor Laboratory. Funded under Grant

P41-RR02188 by the National Institutes of Health.

Portions copyright 1996, 1997, 1998, 1999, 2000, 2001, 2002 by Boutell.Com, Inc.

Portions relating to GD2 format copyright 1999, 2000, 2001, 2002 Philip Warner.

Portions relating to PNG copyright 1999, 2000, 2001, 2002 Greg Roelofs.

Portions relating to gdttf.c copyright 1999, 2000, 2001, 2002 John Ellson (ellson@lucent.com).

Portions relating to gdft.c copyright 2001, 2002 John Ellson (ellson@lucent.com).

Portions relating to JPEG and to color quantization copyright 2000, 2001, 2002, Doug Becker and copyright (C) 1994, 1995, 1996, 1997, 
1998, 1999, 2000, 2001, 2002, Thomas G. Lane. This software is based in part on the work of the Independent JPEG Group. See the file 
README-JPEG.TXT for more information. Portions relating to WBMP copyright 2000, 2001, 2002 Maurice Szmurlo and Johan Van den 
Brande.

Permission has been granted to copy, distribute and modify gd in any context without fee, including a commercial application, provided that 
this notice is present in user-accessible supporting documentation.

This does not affect your ownership of the derived work itself, and the intent is to assure proper credit for the authors of gd, not to interfere 
with your productive use of gd. If you have questions, ask. "Derived works" includes all programs that utilize the library. Credit must be 
given in user-accessible documentation.

This software is provided "AS IS." The copyright holders disclaim all warranties, either express or implied, including but not limited to 
implied warranties of merchantability and fitness for a particular purpose, with respect to this code and accompanying documentation.

Although their code does not appear in gd, the authors wish to thank David Koblas, David Rowley, and Hutchison Avenue Software 
Corporation for their prior contributions.

This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)

MediaCentral may use OpenLDAP.  Copyright 1999-2003 The OpenLDAP Foundation, Redwood City, California, USA. All Rights 
Reserved.  OpenLDAP is a registered trademark of the OpenLDAP Foundation.

Media | Distribute enables its users to access certain YouTube functionality, as a result of Avid's licensed use of YouTube's API. The 
charges levied by Avid for use of Media | Distribute are imposed by Avid, not YouTube. YouTube does not charge users for accessing 
YouTube site functionality through the YouTube APIs.

Media | Distribute uses the bitly API, but is neither developed nor endorsed by bitly.

Android is a trademark of Google Inc.

The following disclaimer is required by Apple Computer, Inc.:
APPLE COMPUTER, INC. MAKES NO WARRANTIES WHATSOEVER, EITHER EXPRESS OR IMPLIED, REGARDING THIS 
PRODUCT, INCLUDING WARRANTIES WITH RESPECT TO ITS MERCHANTABILITY OR ITS FITNESS FOR ANY PARTICULAR 
PURPOSE. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION MAY 
NOT APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH SPECIFIC LEGAL RIGHTS. THERE MAY BE OTHER RIGHTS THAT 
YOU MAY HAVE WHICH VARY FROM STATE TO STATE.

The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of their TIFF library:
Copyright © 1988–1997 Sam Leffler 
Copyright © 1991–1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software [i.e., the TIFF library] and its documentation for any purpose is hereby 
granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the software and 
related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to 
the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

http://www.avid.com/US/about-avid/legal-notices/patent-marking
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THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, 
INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR 
CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR 
PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT 
OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The following disclaimer is required by the Independent JPEG Group:
This software is based in part on the work of the Independent JPEG Group.

This Software may contain components licensed under the following conditions:
Copyright (c) 1989 The Regents of the University of California. All rights reserved. 

Redistribution and use in source and binary forms are permitted provided that the above copyright notice and this paragraph are 
duplicated in all such forms and that any documentation, advertising materials, and other materials related to such distribution and use 
acknowledge that the software was developed by the University of California, Berkeley. The name of the University may not be used to 
endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED ``AS 
IS'' AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 

Copyright (C) 1989, 1991 by Jef Poskanzer. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, 
provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in 
supporting documentation. This software is provided "as is" without express or implied warranty. 

Copyright 1995, Trinity College Computing Center. Written by David Chappell. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, 
provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in 
supporting documentation. This software is provided "as is" without express or implied warranty. 

Copyright 1996 Daniel Dardailler. 

Permission to use, copy, modify, distribute, and sell this software for any purpose is hereby granted without fee, provided that the above 
copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation, 
and that the name of Daniel Dardailler not be used in advertising or publicity pertaining to distribution of the software without specific, 
written prior permission. Daniel Dardailler makes no representations about the suitability of this software for any purpose. It is provided "as 
is" without express or implied warranty. 

Modifications Copyright 1999 Matt Koss, under the same license as above. 

Copyright (c) 1991 by AT&T. 

Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire notice 
is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the supporting 
documentation for such software. 

THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, NEITHER 
THE AUTHOR NOR AT&T MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE MERCHANTABILITY 
OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

This product includes software developed by the University of California, Berkeley and its contributors.

The following disclaimer is required by Nexidia Inc.:
© 2010 Nexidia Inc.  All rights reserved, worldwide.  Nexidia and the Nexidia logo are trademarks of Nexidia Inc. All other trademarks are 
the property of their respective owners.  All Nexidia materials regardless of form, including without limitation, software applications, 
documentation and any other information relating to Nexidia Inc., and its products and services are the exclusive property of Nexidia Inc. 
or its licensors.  The Nexidia products and services described in these materials may be covered by Nexidia's United States patents: 
7,231,351; 7,263,484; 7,313,521; 7,324,939; 7,406,415, 7,475,065; 7,487,086 and/or other patents pending and may be manufactured 
under license from the Georgia Tech Research Corporation USA. 

The following disclaimer is required by Paradigm Matrix:
Portions of this software licensed from Paradigm Matrix.

The following disclaimer is required by Ray Sauers Associates, Inc.:
“Install-It” is licensed from Ray Sauers Associates, Inc. End-User is prohibited from taking any action to derive a source code equivalent of 
“Install-It,” including by reverse assembly or reverse compilation, Ray Sauers Associates, Inc. shall in no event be liable for any damages 
resulting from reseller’s failure to perform reseller’s obligation; or any damages arising from use or operation of reseller’s products or the 
software; or any other damages, including but not limited to, incidental, direct, indirect, special or consequential Damages including lost 
profits, or damages resulting from loss of use or inability to use reseller’s products or the software for any reason including copyright or 
patent infringement, or lost data, even if Ray Sauers Associates has been advised, knew or should have known of the possibility of such 
damages.

The following disclaimer is required by Videomedia, Inc.:
“Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, including warranties with respect to 
its merchantability or its fitness for any particular purpose.”
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“This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 products developed by Videomedia, 
Inc. and V-LAN ver. 3.0 compatible products developed by third parties under license from Videomedia, Inc. Use of this software will allow 
“frame accurate” editing control of applicable videotape recorder decks, videodisc recorders/players and the like.” 

The following disclaimer is required by Altura Software, Inc. for the use of its Mac2Win software and Sample Source 
Code:
©1993–1998 Altura Software, Inc.

The following disclaimer is required by Ultimatte Corporation:
Certain real-time compositing capabilities are provided under a license of such technology from Ultimatte Corporation and are subject to 
copyright protection.

The following disclaimer is required by 3Prong.com Inc.:
Certain waveform and vector monitoring capabilities are provided under a license from 3Prong.com Inc.

The following disclaimer is required by Interplay Entertainment Corp.:
The “Interplay” name is used with the permission of Interplay Entertainment Corp., which bears no responsibility for Avid products.

This product includes portions of the Alloy Look & Feel software from Incors GmbH.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

© DevelopMentor

This product may include the JCifs library, for which the following notice applies:
JCifs © Copyright 2004, The JCIFS Project, is licensed under LGPL (http://jcifs.samba.org/). See the LGPL.txt file in the Third Party 
Software directory on the installation CD.

Avid Interplay contains components licensed from LavanTech. These components may only be used as part of and in connection with Avid 
Interplay.

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or “commercial 
computer software documentation.” In the event that such Software or documentation is acquired by or on behalf of a unit or agency of the 
U.S. Government, all rights with respect to this Software and documentation are subject to the terms of the License Agreement, pursuant 
to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks
Avid, the Avid Logo, Avid Everywhere, Avid DNXHD, Avid DNXHR, Avid Nexis, AirSpeed, Eleven, EUCON, Interplay, iNEWS, ISIS, Mbox, 
MediaCentral, Media Composer, NewsCutter, Pro Tools, ProSet and RealSet, Maestro, PlayMaker, Sibelius, Symphony, and all related 
product names and logos, are registered or unregistered trademarks of Avid Technology, Inc. in the United States and/or other countries. 
The Interplay name is used with the permission of the Interplay Entertainment Corp. which bears no responsibility for Avid products. All 
other trademarks are the property of their respective owners.  For a full list of Avid trademarks, see: 
http://www.avid.com/US/about-avid/legal-notices/trademarks.

Avid Media | Distribute Installation and Configuration Guide • Created 9/26/16 • This document is distributed by Avid in 
online (electronic) form only, and is not available for purchase in printed form.

http://www.apache.org/
http://jcifs.samba.org/
http://www.avid.com/US/about-avid/legal-notices/trademarks
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Using This Guide

This guide is intended for users of MediaCentral | UX with the Media | Distribute feature. This guide 
describes the installation and configuration procedures for Media Distribute, such as installing the 
Media Distribute software and configuring system accounts.

For information on using the publishing features of Media Distribute, see the Media | Distribute 
User’s Guide or the MediaCentral | UX Help. For administrative information for MediaCentral | UX, 
see the Avid MediaCentral | UX Administration Guide.



1 Installation for Media | Distribute

The supported configuration for Media Distribute requires you to install Media Distribute on your 
MediaCentral | UX server, which is part of your MediaCentral installation and configuration. For 
installation information, see the Avid MediaCentral Platform Services Installation and Configuration 
Guide.

The Media Distribute installation procedures assume you have installed Avid MediaCentral Platform 
Services (MCS). You must extract the Media Distribute installation package from 
Media_Distribute_[version]Build[xx]_Linux.tar.gz. You run the installation file itself from a shell 
script called install.sh. This installs the plug-in needed for MediaCentral UX to access the Media 
Distribute functionality, as well as the avid-mpd service which provides the functionality for Media 
Distribute workflows.

The procedures for installing Media Distribute depend on whether you install the application 
components in a cluster environment or on a single MediaCentral server.

• If you deploy MCS and components on a master node and one or more non-master nodes in a 
cluster configuration, see “Installing and Upgrading Media | Distribute in a Cluster 
Environment” on page 9.

• If you deploy all MCS and components on a single server, see “Installing and Upgrading 
Media | Distribute on a Single Server” on page 18.

If necessary for security considerations, you can configure Media Distribute to communicate with the 
Internet through a proxy server. For more information, see “Modifying Media | Distribute to Work 
with a Proxy Server” on page 21.

The following installed components are necessary for the current version of Media Distribute:

• Avid MediaCentral Platform Services v2.8.x (if you work with a cluster configuration, you need 
to ensure that all nodes in the cluster function properly)

• iNEWS 3.4.3 or later (for MCS configurations with iNEWS)

• Interplay MAM 5.6 (for MCS configurations with Avid Interplay Media Asset Manager)

• Avid ISIS v4.7.6 driver

n MediaCentral Platform Services includes a copy of both the Avid ISIS Client and the Avid NEXIS 
Client software. The ISIS Client is installed by default through the MCS v2.8.x installation process. 
The NEXIS Client is bundled with the MCS software for convenience and is not actively installed. 
Verify the version of the Avid NEXIS or Avid ISIS client required for your environment and upgrade 
the client software if necessary.

• Red Had Enterprise Linux (RHEL) v6.5

• MediaCentral Distribution Service
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You also need to ensure that the following are available for Media Distribute:

• Interplay Media Services Engine

• Interplay Transfer engine

• At least one installed transcode provider

• STP encoder

• Internet connection for publishing to social media sites

Installing and Upgrading Media | Distribute in a Cluster 
Environment

The procedures in this section assume you have already installed and configured your MediaCentral 
Platform Services on your clustered servers. For more information on configuring a MediaCentral 
cluster environment, see the Avid MediaCentral Platform Services Installation and Configuration 
Guide. To configure Media Distribute, you require the following:

• RHEL and MediaCentral software components are installed on all servers in the cluster.

• All servers are set up and configured correctly for the cluster.

• Failover processes work correctly.

Installing Media Distribute entails the following steps:

• Copying the Media Distribute installation files to a USB drive.

• Identifying the master and non-master nodes in your configuration, and identifying the virtual 
cluster IP address (see “Identifying the Master and Non-Master Nodes” on page 10 and 
“Identifying the Virtual Cluster IP” on page 10).

• Installing Media Distribute on the master and all non-master nodes in your cluster configuration.

• Setting up the Media Distribute database on the master node of the cluster. You must install 
Media Distribute on all nodes, but you only configure the database once.

• Modifying the MCS configuration file to change the host address to the virtual cluster IP of the 
cluster.

c If you deploy all MCS and components on a single server, see “Installing and Upgrading 
Media | Distribute on a Single Server” on page 18.

After you have installed and configured Media Distribute on your master and non-master nodes, you 
need to restart some MediaCentral Platform and Media Distribute services.

If you need to remove Media Distribute, see “Removing Media | Distribute” on page 23.

For installation procedures, see the following topics:

• “Installing and Upgrading Media | Distribute” on page 11

• “Configuring Media | Distribute on the Master Node” on page 14

• “Configuring the Media | Distribute Installation on Non-Master Nodes” on page 16

The Media Distribute software installation package file 
(Media_Distribute_[version]Build[xx]_Linux.tar.gz) is available to Avid Support representatives 
only and can be downloaded from the Avid Gold Build repository.
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To prepare and mount a USB drive for Media Distribute installation:

1. On a Windows system, format a USB drive as a FAT32 volume.

2. Get the Media Distribute installation package file 
(Media_Distribute_[version]Build[xx]_Linux.tar.gz) from your Avid representative.

3. Copy the compressed installation file to the USB drive.

4. Remove the USB device from the Windows system.

Identifying the Master and Non-Master Nodes

You can use the cluster resource monitoring command, crm, to verify which server functions as the 
master node and which as the non-master nodes.

To identify the master and non-master nodes, do the following:

t Log in to any node in the cluster as root and open the cluster resource monitoring utility by 
typing the following: crm resource status

The status of all cluster-related services on all nodes displays in the terminal window. 

The master and non-master nodes are indicated as the Master/Slave Set — for example:

Master/Slave Set: ms_drbd_postgres [drbd_postgres]

Masters: [ morpheus-hp1 ]

Slaves: [ morpheus-hp2 ]

Identifying the Virtual Cluster IP

Some configuration files used in the configuration of your Media Distribute installation require the 
virtual cluster IP. This is required for the correct configuration of the Media Distribute service in a 
cluster installation.

To identify the virtual cluster IP:

t Log in to the master node of the cluster and type the following command: ifconfig

The following is a example of the output of a typical network interface configuration. The virtual 
cluster IP is the IP assigned to the 'eth0:c10' network adapter. In this example, the virtual cluster 
IP is 172.24.18.61.

eth0 Link encap:Ethernet  HWaddr 00:26:55:E6:83:E1

inet addr:172.24.18.163  Bcast:172.24.18.255  Mask:255.255.255.0

inet6 addr: fe80::226:55ff:fee6:83e1/64 Scope:Link

UP BROADCAST RUNNING MULTICAST  MTU:1500  Metric:1

RX packets:4321802 errors:0 dropped:0 overruns:0 frame:0

TX packets:3628475 errors:0 dropped:0 overruns:0 carrier:0

collisions:0 txqueuelen:1000

RX bytes:1374391088 (1.2 GiB)  TX bytes:1086706641 (1.0 GiB)

eth0:cl0 Link encap:Ethernet  HWaddr 00:26:55:E6:83:E1
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Installing and Upgrading Media | Distribute

If you install Media Distribute in a cluster environment, you must install it first on the master node of 
the cluster since the database service runs on this node. The installation includes creating a database 
for the Media Distribute service. This can only be done on the node with the running PostgreSQL 
service. After you install the application on the master node, you must install Media Distribute on all 
non-master nodes.

n When you finish the master node installation, you might see a message during the installation on 
non-master nodes; “Not running a database PG on localhost. Please enter IP of database server.” If 
you see this message, press Enter. You do not need to provide an IP address for your database server 
when installing Media Distribute on a non-master node.

The procedure for upgrading Media Distribute is similar to the one you used initially to install Media 
Distribute. The upgrade procedure overwrites some configuration files. You can restore some of these 
files by using the backup configuration files already in your configuration once the upgrade 
completes. For other files — for example, the Avid Publish Service configuration files — you must 
edit the new versions if you made any customizations to the original configuration.

n When you upgrade your version of Media Distribute, all system and user settings are saved. You do 
not need to create new settings, but if the newer version includes new features, you might need to 
modify your settings to activate the features. For a list of new features, see the ReadMe 
documentation that came with your version of MediaCentral UX. For information on setting up 
account profiles, see “Configuring System Accounts for Media | Distribute” on page 57.

c The Media Distribute installation, upgrade, and configuration disconnects all users logged in to 
MediaCentral UX when it restarts some services. Ensure that all users save their sessions and 
log off during the installation or upgrade procedures.

inet addr:172.24.18.61  Bcast:172.24.18.189  Mask:255.255.255.255

UP BROADCAST RUNNING MULTICAST  MTU:1500  Metric:1

Interrupt:38 Memory:fbde0000-fbe00000

lo Link encap:Local Loopback

inet addr:127.0.0.1  Mask:255.0.0.0

inet6 addr: ::1/128 Scope:Host

UP LOOPBACK RUNNING  MTU:16436  Metric:1

RX packets:7331022 errors:0 dropped:0 overruns:0 frame:0

TX packets:7331022 errors:0 dropped:0 overruns:0 carrier:0

collisions:0 txqueuelen:0

RX bytes:8040287442 (7.4 GiB)  TX bytes:8040287442 (7.4 GiB)
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To install or upgrade Media Distribute:

1. Insert the Media Distribute installation USB drive into the server.

2. Verify the name of the device by typing the following command: dmesg

Linux information relating to hardware appears on the screen.

Information for the USB device appears near the end of the output, near the list of SCSI devices. 
The name of the USB device is found inside square brackets (e.g., sdc). This is the name you use 
to mount the device.

3. Create a mount point for the USB device by typing the following: mkdir /media/usb

4. Mount the USB key at the mount point you just created: 

mount -t vfat /dev/sdc<?> /media/usb

n The name of the USB device (sdc, in this case) takes a 1 (one) in the mount command. This simply 
indicates a partition exists on the USB device. Formatting the USB device in Windows created the 
partition.

The USB device is now mounted and available for use.

5. Verify the USB key has been mounted: df -h

Information displays about all mounted file systems and devices, including information about the 
USB device, similar to the following:

6. Unpack the Media Distribute installation file by typing the following command:

tar -xzf /media/usb/Media_Distribute_<version>Build<xx>_Linux.tar.gz

The compressed file extracts to a subfolder within the target directory called 
Media_Distribute_[version]_Build_[xx]_Linux.

7. Navigate to the installation directory:

cd Media_Distribute_<version>_Build_<xx>_Linux

8.  Run the installation script: 

./install.sh

n For master node installations, a default user in the PostgreSQL database is created with a user name 
of mpduser and a password of resudpm. The necessary database tables and schema in PostgreSQL 
database are also created.

9. Follow the prompts to install Media Distribute.

File system Size Used Avail Use % Mounted on

/dev/sdc1 7.5 G 4.5 G 3.0 G 61 % /media/usb
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10. Do the following to open the MediaCentral Configurator, and then ensure that the Media 
Distribute plug-in is enabled within the Configurator:

a. Type the following command:

/opt/avid/avid-interplay-central/configurator

b. Select MediaDistribute.

When the MediaCentral Configurator completes, a dialog box opens.

11. Press Enter to select No.

The Configurator closes.

12. To restart the MediaCentral service, type the following command:

crm resource restart AvidIPC

n When you restart the services, all users currently logged on to MediaCentral UX are logged out. 
Restarting the services might take up to a minute.

13. (Master node only) To verify the version of Media Distribute installed on a master node, type the 
following command:

/usr/share/apache-servicemix/bin/mpd_version

The command returns the installed versions of ServiceMix and Media Distribute. For example:

ServiceMix   Version: 4.5.1
MPD          Version: 2.6.0.20150122_114231
MPD UI       Version: 2.6.0.20150122_114231

14. (Master node only) To verify the ServiceMix installation on a master node, do the following:

a. Type the following

ssh Administrator@localhost -p 8101

b. Type yes to continue connecting to the host, and then type the default password avid.
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c. Type list, and press Enter.

All account endpoints display as “Active” and the Social Media Integration route displays as 
“Started.”

n If not all endpoints are active or if the Social Media Integration route is not started, ServiceMix 
might not have completed restarting. You can wait a moment and then retry these steps.

d. To quit ServiceMix, type logout.

15. To remove the installation files and unmount the USB drive, do the following:

a. Type cd / to ensure you are not currently on the USB key by changing to the root directory.

b. Type the following:

rm -rf <target_directory>

umount /media/usb

c. Remove the USB drive from the server.

Configuring Media | Distribute on the Master Node

After you install Media Distribute, you must edit several configuration and property files and restart 
services on the master cluster node before you can use Media Distribute.

To configure PostgreSQL to allow remote hosts access to the Media Distribute database:

1. Using Linux commands, navigate to the directory containing the PostgreSQL database 
configuration file: 

cd /mnt/drbd/postgres_data

2. Using the Linux text editor, vi, open the pg_hba.conf file for editing:

vi pg_hba.conf

3. Type G to go to the last line of the file, and then Type i (lower case “i”) to enter insert mode and 
move to the new line.

4. Add the following to the last line:

host    mpd     mpduser         0.0.0.0/0               trust

5. Press the Escape key to return to command mode, then type :wq and press Enter to write and quit 
the text editor.
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To configure the User Management Service (UMS) properties file (new installation only):

1. Using Linux commands, navigate to the directory containing the UMS properties file: 

cd /usr/share/apache-servicemix/config

2. Using the Linux text editor, vi, open the application.properties file for editing:

vi application.properties

3. Navigate using the arrow keys to the next line: 

com.avid.mpd.uls.host.retriever=application.properties

4. If the line is commented with a # character, place the cursor over the # character and type x to 
delete the character and uncomment the line.

5. Navigate using the arrow keys to the line containing the parameter for 

com.avid.osgi.uls.host

6. Type a valid UMS REST address.

The default value is https://localhost:10443/ws/rest. Use the virtual cluster IP address 
as the host for this configuration file — for example, type 
https://123.45.67.89:10443/ws/rest

7. Press the Escape key to return to command mode, then type :wq and press Return to write and 
quit the text editor.

To configure PostgreSQL to allow remote hosts access to the Media Distribute database (new 
installation only):

1. Navigate to the directory containing the Media Distribute database configuration file:

cd /etc/apache-servicemix

2. Using the Linux text editor, vi, open the avid-mpd-wrapper.conf file for editing:

vi avid-mpd-wrapper.conf

3. Locate the following line, and then navigate using the arrow keys and place the cursor on top of 
the # (comment indicator):

# set.default.DB_HOST=hostname or IP

4. Type i (lower case “i”) to enter insert mode, and then use the arrow keys and backspace to erase 
the # (comment indicator).

5. Delete the hostname or IP value at the end of the line, and then replace it by typing the virtual 
cluster IP address — for example, set.default.DB_HOST=123.45.67.89

6. Press the Escape key to return to command mode, then type :wq and press Return to write and 
quit the text editor.

To modify the bus configuration file (new installation only):

1. Using Linux commands, navigate to the directory containing the MediaCentral configuration 
file: cd /etc/apache-servicemix.

2. Using the Linux text editor, vi, open the 
com.avid.acs.bus.broker.rabbitmq.RabbitMqBusAccessFactory.cfg file for editing:

vi com.avid.acs.bus.broker.rabbitmq.RabbitMqBusAccessFactory.cfg

3. Navigate using the arrow keys to the line containing the parameter for brokerConnectURL.
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4. Type i (lower case “i”) to enter insert mode, and then type a valid URL for the MediaCentral 
connection.

The default value is amqp://localhost/acs. Use the virtual cluster IP address as the host for 
this configuration file — for example, amqp://123.45.67.89/acs

5. Press the Escape key to return to command mode, then type :wq and press Return to write and 
quit the text editor.

6. To restart the Media Distribute service, type the following command:

service avid-mpd clean-restart

To restore and move the Servicemix configuration files (upgraded systems only):

t For Media Distribute upgrades, restore the Servicemix configuration files by doing the 
following:

a. Type the following to navigate to the Servicemix directory: 

cd /etc/apache-servicemix/

b. Type the following commands to restore the backup configuration files:

mv avid-mpd-wrapper.conf.rpmsave avid-mpd-wrapper.conf

mv 
com.avid.acs.bus.broker.rabbitmq.RabbitMqBusAccessFactory.cfg.rpmsave 
com.avid.acs.bus.broker.rabbitmq.RabbitMqBusAccessFactory.cfg

Configuring the Media | Distribute Installation on Non-Master Nodes

Once you have installed Media Distribute on the master node, you must install the application on all 
non-master nodes. For installation procedures, see “Installing and Upgrading Media | Distribute” on 
page 11.

After the installation or upgrade is complete, you must edit several configuration and property files 
and restart services on all non-master nodes in your cluster before you can use Media Distribute. 
Since the edited configuration and property files are identical to the ones you edited on the master 
node, you can copy those files to the non-master nodes.

To copy the edited Media Distribute files from the master to the non-master nodes:

1. Log in to your non-master node server using the root account.

2. Open a Linux terminal window, and then type the following commands:

scp root@<hostname>:/etc/apache-servicemix/avid-mpd-wrapper.conf 
/etc/apache-servicemix/

scp root@<hostname>:/etc/apache-servicemix/
com.avid.acs.bus.broker.rabbitmq.RabbitMqBusAccessFactory.cfg 
/etc/apache-servicemix/

scp root@<hostname>:/usr/share/apache-servicemix/config/
application.properties /usr/share/apache-servicemix/config/

n <hostname> is the host name of your master node. 
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The terminal window displays the following message:

The authenticity of host '<hostname (IP address)>' can't be established.

RSA key fingerprint is <fingerprint alphanumerical id>.

Are you sure you want to continue connecting (yes/no)?

3. Type yes.

The terminal window displays the following message:

Warning: Permanently added '<hostname, IP address>' (RSA) to the list of 
known hosts.

4. If prompted for a password, type the password for your root user account.

The edited files are copied to the non-master node.

5. To restart the Media Distribute service, type the following command:

service avid-mpd clean-restart

To verify the ServiceMix installation, do the following:

1. Type the following

ssh Administrator@localhost -p 8101

2. Type yes to continue connecting to the host, and then type the default password avid.

3. Type list, and press Enter.

All account endpoints display as “Active” and the Social Media Integration route displays as 
“Started.”

4. To quit ServiceMix, type logout.

Restarting PostgreSQL Service and Verifying the Cluster Installation

Before you verify your Media Distribute installation on the master and non-master nodes, you need 
to perform a failover of the servers. This restarts the PostgreSQL service and validates the mpduser. It 
also tests your new installation and verifies that both Media Distribute and MediaCentral Platform 
Services are running properly.
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To perform a failover and verify your installation:

1. Open a terminal window and log in to any non-master node in the cluster as root and check the 
cluster resource status by typing the following: crm_mon -f

The status of all cluster-related services on all nodes displays in the terminal window. The 
Migration summary also displays at the bottom of the screen, which can be useful to view errors 
and fail counts per node.

2. On the master node, type the following, and then press Enter: crm node standby <hostname>

Replace <hostname> with the hostname of the master node — for example, wavd-mcs01.

3. Monitor the cluster information displayed on the slave node as it updates its information.

As the slave node becomes the master node, it takes ownership of the PostgreSQL database. This 
process takes several seconds to complete.

4. When the updated cluster is stable, bring the standby mode back online by typing the following 
and press Enter: crm node online <hostname> 

Replace <hostname> with the name of the offline node (e.g. wavd-mcs01).

The offline node is brought back up and rejoins the cluster.

5. Monitor the cluster information displayed on the node as it updates its information.

When the node on standby comes online, its status is that of the slave node.

6. Repeat the process to test failover in the opposite direction. 

As the master node goes into standby mode, the status of the slave node returns to that of the 
master node. When the standby node comes back online, its status is that of the slave node.

Installing and Upgrading Media | Distribute on a Single 
Server

The Media Distribute software installation package file 
(Media_Distribute_[version]_Build_[xx]_Linux.tar.gz) is available to Avid Support representatives 
only and can be downloaded from the Avid Gold Build repository.

c If you deploy MCS and components on a master node and one or more non-master nodes in a 
cluster configuration, see “Installing and Upgrading Media | Distribute in a Cluster 
Environment” on page 9.

To prepare and mount a USB drive for Media Distribute installation:

1. On a Windows system, format a USB drive as a FAT32 volume.

2. Get the Media Distribute installation package file 
(Media_Distribute_[version]_Build_[xx]_Linux.tar.gz) from your Avid representative.

3. Copy the compressed installation file to the USB drive.

4. Remove the USB device from the Windows system.
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Installing and Upgrading Media | Distribute on a Server

You can install or upgrade Media Distribute on a single server The installation includes creating a 
database for the Media Distribute service.

The procedure for upgrading Media Distribute is similar to the one you used initially to install Media 
Distribute. If you need to remove Media Distribute, see “Removing Media | Distribute” on page 23.

n When you upgrade your version of Media Distribute, all system and user settings are saved. You do 
not need to create new settings, but if the newer version includes new features, you might need to 
modify your settings to activate the features. For a list of new features, see the ReadMe 
documentation that came with your version of MediaCentral UX. For information on setting up 
account profiles, see “Configuring System Accounts for Media | Distribute” on page 57.

c The Media Distribute installation and configuration disconnects all users logged in to 
MediaCentral UX when it restarts some services. Ensure that all users save their sessions and 
log off during the installation or upgrade procedures.

To install or upgrade Media Distribute:

1. Insert the Media Distribute installation USB drive into the master node server.

2. Verify the name of the device by typing the following command: dmesg

Linux information relating to hardware appears on the screen.

Information for the USB device appears near the end of the output, near the list of SCSI devices. 
The name of the USB device is found inside square brackets (e.g., sdc). This is the name you use 
to mount the device.

3. Create a mount point for the USB device by typing the following: mkdir /media/usb

4. Mount the USB key at the mount point you just created: 

mount -t vfat /dev/sdc<?> /media/usb

n The name of the USB device (sdc, in this case) takes a 1 (one) in the mount command. This simply 
indicates a partition exists on the USB device. Formatting the USB device in Windows created the 
partition.

The USB device is now mounted and available for use.

5. Verify the USB key has been mounted: df -h

Information displays about all mounted file systems and devices, including information about the 
USB device, similar to the following:

6. Unpack the Media Distribute installation file by typing the following command:

tar -xzf /media/usb/Media_Distribute_<version>Build<xx>_Linux.tar.gz

The compressed file extracts to a subfolder within the target directory called 
Media_Distribute_[version]_Build_[xx]_Linux.

7. Navigate to the installation directory:

cd Media_Distribute_<version>_Build_<xx>_Linux

File system Size Used Avail Use % Mounted on

/dev/sdc1 7.5 G 4.5 G 3.0 G 61 % /media/usb
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8.  Run the installation script: 

./install.sh

n A default user in the PostgreSQL database is created with a user name of mpduser and a password of 
resudpm. The necessary database tables and schema in PostgreSQL database are also created.

9. Follow the prompts to install Media Distribute.

10. To verify the package has been installed, type the following:

/usr/share/apache-servicemix/bin/mpd_version

The output should include the following lines:

apache-servicemix.noarch 0:4.5.1-avid.el6.5

avid-mpd-<Version>.<Build>-avid.el6.1.noarch.rpm

avid-media-central-mpd-<Version>.<Build>-avid.el6.1.noarch.rpm

11. Type the following to open the MediaCentral Configurator, and then ensure that the Media 
Distribute plug-in is enabled within the Configurator:

/opt/avid/avid-interplay-central/configurator

n When you exit MediaCentral Configurator, you are asked to restart the MediaCentral services. When 
you restart the services, all users currently logged on to MediaCentral UX are logged out.

12. To verify the ServiceMix installation, do the following:

a. Type the following

ssh Administrator@localhost -p 8101

b. Type yes to continue connecting to the host, and then type the default password avid.

c. Type list, and press Enter.

If the ServiceMix installation is successful, all account endpoints display as “Active” and the 
Social Media Integration route displays as “Started.”

d. To quit ServiceMix, type logout.
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13. To unmount the USB drive, do the following:

a. Type cd / to ensure you are not currently on the USB key by changing to the root directory.

b. Type the following:

rm -rf <target_directory>

umount /media/usb

c. Remove the USB drive from the server.

Modifying Media | Distribute to Work with a Proxy 
Server

Media Distribute installations include an instance of ServiceMix that requires external connectivity 
to the Internet — for example, to post packages to Facebook or Twitter. Both Media Distribute and 
ServiceMix reside on the MediaCentral server connected to your internal network. This might create 
potential security issues for certain customers. For secure deployment considerations, you can 
configure Media Distribute to communicate with the Internet through a proxy server.

Using a proxy server — such as a Squid server or any other proxy server running on another machine 
in the network — allows you to restrict the ports that ServiceMix uses and the specific Internet sites 
with which it communicates. This solution involves configuration changes only and does not require 
changes to the existing Media Distribute installation process. After installing Media Distribute, you 
need to modify the Service Mix configuration file to include the proxy settings to ensure that all 
requests and responses go through the proxy server. When you restart Media Distribute services, any 
ServiceMix communication is forwarded to the proxy server.

When you have configured Media Distribute to use a proxy server, you must configure the proxy 
server with the following information:

• IP addresses of all ServiceMix instances, so that only data originating from Media Distribute are 
allowed to the proxy server

•  Social media targets for the destination domains — for example, api.twitter.com

You can also specify some systems in your configuration to bypass the proxy server. This can be 
useful in some configurations where you need to access the intranet — for example, when using a 
Vantage transcoder — where direct access works better.

See the documentation that came with your proxy server installation for more information on how to 
configure it for proxy operation.

The following procedure describes how to modify the ServiceMix properties file. It assumes you 
have set up and configured a proxy server. 

To modify the ServiceMix configuration file for using Media Distribute with a proxy server:

1. Navigate to the directory containing the Media Distribute database configuration file:

cd /etc/apache-servicemix

2. Using the Linux text editor, vi, open the avid-mpd-wrapper.conf file for editing:

vi avid-mpd-wrapper.conf

3. Locate the section called Proxy configuration, and then type i (lower case “i”) to enter insert 
mode.
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4. Locate the following lines, type i (lower case “i”) to enter insert mode, and then use the arrow 
keys and backspace to erase the # (comment indicator) on all lines except those for setting the 
proxy user name and proxy password (these are optional parameters):

#wrapper.java.additional.n=-Dhttp.proxySet=true

#wrapper.java.additional.n=-Dhttp.proxyHost=<the proxy host>

#wrapper.java.additional.n=-Dhttp.proxyPort=<the proxy port>

#wrapper.java.additional.n=-Dhttp.proxyUser=<the proxy username>

#wrapper.java.additional.n=-Dhttp.proxyPassword=<the proxy password>

#wrapper.java.additional.n=-Dhttps.proxySet=true

#wrapper.java.additional.n=-Dhttps.proxyHost=<the proxy host>

#wrapper.java.additional.n=-Dhttps.proxyPort=<the proxy port>

#wrapper.java.additional.n=-Dhttps.proxyUser=<the proxy username>

#wrapper.java.additional.n=-Dhttps.proxyPassword=<the proxy password>

5. (Optional) If you want to specify some systems to bypass the proxy server, erase the # (comment 
indicator) on the following line:

#wrapper.java.additional.n=-Dhttp.nonProxyHosts=<the proxy hosts>

n You can add systems to this exclusion by separating them with a pipe symbol (|).

6. Delete the numeral variable (.n) and number the lines for which you have removed the comment 
indicator.

7. Delete the <proxy host> or <proxy port> variable and then replace it by typing the IP address of 
your proxy server or by typing the port configured by your proxy server for both the HTTP and 
HTTPS settings.

n Typically the proxy port is 3128.

The modified configuration should look like the following example:

wrapper.java.additional.1=-Dhttp.proxySet=true

wrapper.java.additional.2=-Dhttp.proxyHost=12.345.67.89

wrapper.java.additional.3=-Dhttp.proxyPort=3128

#wrapper.java.additional.n=-Dhttp.proxyUser=<the proxy username>

#wrapper.java.additional.n=-Dhttp.proxyPassword=<the proxy password>

wrapper.java.additional.4=-Dhttps.proxySet=true

wrapper.java.additional.5=-Dhttps.proxyHost=12.345.67.89

wrapper.java.additional.6=-Dhttps.proxyPort=3128

#wrapper.java.additional.n=-Dhttps.proxyUser=<the proxy username>

#wrapper.java.additional.n=-Dhttps.proxyPassword=<the proxy password>

8. Press the Escape key to return to command mode, then type :wq and press Return to write and 
quit the text editor.

9. To restart the MediaCentral service, type the following command:

service avid-mpd restart
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Removing Media | Distribute

If you want to remove Media Distribute, you can use the procedure described in this section. If you 
need to reinstall Media Distribute, see “Installing and Upgrading Media | Distribute in a Cluster 
Environment” on page 9 or “Installing and Upgrading Media | Distribute on a Single Server” on 
page 18.

To remove Media Distribute on the master node:

1. To check the correct version and build numbers for your installation, type the following:

/usr/share/apache-servicemix/bin/mpd_version

The output should include the following lines:

apache-servicemix.noarch 0:4.5.1-avid.el6.5

avid-mpd-<Version>.<Build>-avid.el6.1.noarch.rpm

avid-media-central-mpd-<Version>.<Build>-avid.el6.1.noarch.rpm

2. Remove the Media Distribute services by typing the following commands:

rpm -e avid-media-central-mpd

rpm -e avid-mpd

n You can copy the lines from the output in the previous step and paste them after the rpm -e 
command.

3. To restart the MediaCentral services, type the following commands:

t For cluster configurations: crm resource restart AvidIPC

t For single-node systems: service avid-interplay-central restart

n When you remove Media Distribute, the Media Distribute Producer role remains in 
MediaCentral UX.



2 Configuration for Media | Distribute

Before you use Avid Media Distribute to publish your content to multiple channels and devices, you 
need to configure MediaCentral | UX for each platform or service you want to use for publishing. 
This allows you to link your media packages and iNEWS stories with distribution to the Web and to 
social media outlets and helping you to automate file preparation and transcoding.

Before you configure your system accounts, you need to need to configure MediaCentral UX for 
Media Distribute. For more information, see the following topics:

• “Assigning Media | Distribute Roles” on page 24

• “Configuring the Transcode Route” on page 31

You can then configure your system and user accounts for Media Distribute:

• “Configuring System Accounts for Media | Distribute” on page 57

• “Configuring User Profiles for Media | Distribute” on page 118

Once you have configured your platforms and services, users can log in to MediaCentral UX and 
start working with the application. For more information on using MediaCentral UX, see the Avid 
MediaCentral UX User’s Guide.

Verifying Your Media | Distribute Installation

Before you start to configure Media Distribute, you can test your installation to verify that all Media 
Distribute components are functioning correctly.

To verify your Media Distribute installation:

1. Sign in to MediaCentral UX as an administrator.

2. Click the Layout selector and select Media Distribute.

If Media Distribute has installed correctly, the following panes display in the Media Distribute 
layout:

- Social Message

- Web Story

- Packages

Assigning Media | Distribute Roles
Media Distribute provides two basic roles for publishing to multiple platforms and managing the 
layouts and permissions associated with them. Before you assign roles, you need to set up an 
administrative account for Media Distribute. Once this administrative account appears in the System 
Settings, the necessary roles are available for Media Distribute.
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If your MediaCentral configuration includes iNEWS, you need to assign an Advance License to the 
two Media Distribute roles before you assign these roles to users. For Interplay Production 
configurations, you can use the default Basic License type for these roles.

For more information about licenses and roles, see the Avid MediaCentral | UX Administration 
Guide.

When you have set up an administrative account and assigned the appropriate license type, you can 
then assign either the Advance Journalist or the Media Distribute Producer role to Media Distribute 
users. Only Media Distribute Producers have access to the review and approval features in the 
Packages pane.

You can assign roles in two ways:

• In the Role Details pane

• In the User or Group Details pane.

If you are upgrading from Media Distribute v1.8 to v2.x, you need to add the Media Distribute layout 
to the Advance Journalist role and to modify the legacy Interplay Pulse Producer role.

To set up an administrative account for Media Distribute:

1. Sign in to MediaCentral UX as an administrator.

2. Select System Settings from the Layout selector. 

The System Settings layout opens.

3. In the Settings pane select Media Distribute > Profiles.

The Settings pane displays the settings in that group.

4. Click the Publication Type menu and select IPC.

5. Click the + (plus) button in the Details section.
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6. Specify the required settings:

- Profile Name (type a descriptive name for your administrative profile)

- Administrative Username

- Administrative Password

7. Click Verify Profile Settings to validate the profile settings.

If your profile is valid, a message displays: “Profile configurations is valid.” If any settings are 
incorrect, a message displays and indicates which fields are incorrect. All invalid settings names 
change to red. 

n The setting, “Transform iNEWS stories to lower case,” applies only to Media Distribute accounts 
that publish packages containing iNEWS stories. The option does not affect this setting.

8. Click Apply to save the profile. 

The profile displays in the Details section with the new information.

If you are editing a profile, click Revert to return to the original settings. If you want to delete a 
profile, select the profile and click the minus (-) button in the Details section.

To assign an Advance License to the Media Distribute roles in the Role Details pane (iNEWS 
configurations only):

1. Select Users from the Layout selector.

2. In the Roles pane, double-click either Advance Journalist or Media Distribute Producer to assign 
to a user or group.

Information about the role is displayed in the Details pane.

3. In the Details pane, select Advance License as the License Type for the following roles:

- Advance Journalist

- Media Distribute Producer

4. Click Apply to save your changes or click Revert to cancel your changes. 



Assigning Media | Distribute Roles

27

To assign a Media Distribute role to a user in the Role Details pane:

1. Select Users from the Layout selector.

2. In the Roles pane, double-click either Advance Journalist or Media Distribute Producer to assign 
to a user or group.

Information about the role is displayed in the Details pane.

3. Click the User Tree pane.

4. Select the user or group to which you which you want to assign the role and drag it to the Users 
and Groups by MediaCentral Zone section of the Details pane.

MediaCentral UX User Settings, with the User Tree and Roles panes.

5. Click Apply to save your changes or click Revert to cancel your changes. 

To assign the Media Distribute layout and create the Media Distribute Producer role (for 
MediaCentral UX upgrade installations only):

1. Select Users from the Layout selector.

2. In the Roles pane, double-click Advance Journalist.

Information about the role is displayed in the Details pane.
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3. In the Layouts pane, click the edit button.

The Add or Remove Layouts dialog box opens.

4. Select Media | Distribute, and then click the Close button.

5. Click Apply to save your changes or click Revert to cancel your changes. 

6. In the Roles pane, double-click Interplay Pulse Producer.

Information about the role is displayed in the Details pane.

7. Modify the role name in the Role Name text box by typing the following: 

Media Distribute Producer

8. Modify the description in the Description text box by typing the following: 

Media Distribute Producer

9. In the Layouts pane, click the edit button.

The Add or Remove Layouts dialog box opens.
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10. Select Media | Distribute, and then click the Close button.

11. Click Apply to save your changes or click Revert to cancel your changes. 

To assign a role in the User or Group Details pane (iNEWS configuration only):

1. Select Users from the Layout selector.

2. In the Roles pane, double-click either Advance Journalist or Media Distribute Producer to assign 
to a user or group.

Information about the role is displayed in the Details pane.

3. Click the User Tree pane.

4. Select the user or group to which you which you want to assign the role and drag it to the Users 
and Groups by MediaCentral Zone section of the Details pane.

MediaCentral UX User Settings, with the User Tree and Roles panes.

5. Click Apply to save your changes or click Revert to cancel your changes. 

MediaCentral | UX Security for Media | Distribute
A MediaCentral client requires user login credentials in order to gain access to the underlying 
functionality. All data transfer to and from the MediaCentral client (user credentials, session 
information, user configuration settings, media images and files, text, and machine instructions) are 
transported in a secure manner to the MediaCentral server using HTTPS protocol. 

MediaCentral clients that connect through the public Internet require a virtual private network (VPN) 
access to the server network. All connections pass through the VPN router/firewall through identified 
ports. Once the data has passed into the “house network” it is secured using the customer’s existing 
network security infrastructure.

For Media Distribute, ports are used for outgoing HTTP traffic and pass through a network firewall. 
In some cases, a platform or a system account might require a separate port for outgoing FTP data. 
Media Distribute does not require any ports for incoming data.

c Do not enable a firewall on the servers in your Media Distribute configuration.
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The following tables list the ports used by MediaCentral UX and Media Distribute that should be 
allowed through the VPN and network firewalls.

n Outbound ACLs should be used to allow packets from the MediaCentral Platform Services (MCS) 
server to the MediaCentral client over “established” TCP sessions only.

Note that the Interplay Web service and MediaCentral UX application services operate on the same 
server, so there are no proxies or firewalls between these components. Access to the MediaCentral 
database is also direct, with no database firewall protection required. 

Only MediaCentral UX Administrators can access and modify the system data stored within the user 
management database (user credentials, user settings, and system attributes).

For more information on MediaCentral security, see the Avid MediaCentral | UX Security 
Architecture and Analysis.

VPN Firewall Port Settings

Component Port Usage

MediaCentral UX Web application 80 MediaCentral Platform Playback Services (MCPS) 
HTTP calls

443 MediaCentral HTTPS calls

843 Loading the Flash Player for playback

26000 Inbound MCPS data

5000 Serving outbound JPEG images to the Flash player

21 Outgoing FTP data

n Communication over port 21 is only required 
for XML transfer to generic CMS or OVP 
endpoints or for media transfers to the 
WorldNow CMS system and is not required 
as part of any installation that uses standard 
Media Distribute third-party connectors.

MediaCentral UX mobile applications 80 MCPS HTTP calls

443 MediaCentral HTTPS calls

Network Firewall Port Settings

Component Port Usage

MediaCentral UX (these ports are used 
for outbound communication with 
configured endpoints such as Facebook, 
Twitter, or YouTube)

80 MediaCentral Platform Playback Services (MCPS) 
HTTP calls

443 MediaCentral HTTPS calls
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Configuring the Transcode Route
Media Distribute delivers video to the configured online video platforms using the following 
workflow. An understanding of this workflow might help to complete the Send to Playback settings.

• The user publishes a bundle to endpoints that include video assets — for example, YouTube and 
Vimeo. The source videos are stored in Interplay Production.

• To start the publishing process, Media Distribute sends the source video to the MediaCentral 
Distribution server in a send-to-playback operation.

• The Interplay Production media files are mixed down to MXF-wrapped OP1a media. In the 
Packages pane, Media Distribute monitors the process as the status displays as “mixing down.”

n You can send only sequences for mixdown and transfer to an FTP location.

• The Transfer Manager moves the MXF file to the FTP location specified in the Mixing Down 
FTP Path in the Send to Playback system settings — see “Send to Playback Configuration for 
Media | Distribute” on page 37.

n This location is independent of the transcoder. The system supports multiple transcode 
configurations which you can assign to various endpoints. By not delivering the video directly to a 
transcode watch folder, the transcode route is built in a manner that allows for support of multiple 
transcode endpoints.

• The Media Distribute orchestration engine monitors the FTP location. Once the MXF media 
arrives at the FTP location, Media Distribute delivers it to the appropriate transcoder /in folder, 
based on the configuration for your transcoder service (ftp://<transcoder>/transcoding/in).

• Media Distribute submits the transcoding job to the transcoder:

- The File Share in Path value (\\<transcoder_hostname>\avid\transcoding\in) should be 
configured and mapped to the FTP “in” path (ftp://<transcoder>/transcoding/in). The file 
share folder must have the appropriate read/write permissions set. For more information, see 
“Configuring the Video Transcoding Host” on page 33.

- The transcoder workflow should be configured to provide output to the 
ftp://<transcoder>/transcoding/out folder.

• After transcoding, the Media Distribute orchestration engine obtains the transcoded video file 
from the transcoder “out” folder and delivers it to the designed online video provider (OVP) 
endpoint for publication.

In order to enable this workflow, you must configure the Send to Playback system settings to provide 
the necessary information.
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The following illustration outlines the overall workflow for publishing video using Media Distribute. 
Note that some details depend on the specific configuration of your transcoder service — for 
example, Telestream Vantage or Harmonic ProMedia Carbon transcoder.

To transcode and publish video with Media Distribute, you need to provide the following 
configuration:

• Configuration requires that the following servers are available: Avid MediaCentral Distribution 
Service, Interplay Production Services, Interplay Transfer, and MediaCentral Platform Services.

• You must configure the Send to Playback settings to provide mixdown output to an FTP server. 
For more information, see “Configuring for Send to Playback” in the Avid MediaCentral | UX 
Administration Guide. 

67

ftp://[transcoder]/transcoding/out ftp://[transcoder]/transcoding/in

File Share in Path (mixing down) folder

Third-Party Transcoder Service
Online Video

Provider

(For example:
Vimeo, YouTube (mapped folders)

1
2

3

4

5

1 A user creates a media package with video and clicks Post to send it for review and approval. When a 
producer approves the package, it is sent for publication.

2 The sequence, with the source files stored in the Interplay Production database, is mixed down to 
MXF-wrapped OP1a media. In the Packages pane, the status displays as “mixing down.”

3 Media Distribute uses the MediaCentral Distribution Service to monitor the send-to-playback status. 
When the sequence is mixed down, the Transfer Manager profile, configured in Interplay Transfer, 
allows Interplay Transfer to move the MXF file to the Mixing Down FTP Host location.

4 Interplay Transfer moves the media to the Mixing Down FTP Path folder. This folder, specified in the 
STP profile, matches the configuration the Transfer Manager profile. The folder is configured as a shared 
folder.

5 Media Distribute monitors the shared folder, and when the media has been transferred, Media Distribute 
copies the MXF file from the Mixing Down FTP folder to the transcoding/in FTP folder on the 
transcoder service system. The shared folder is mapped to the transcoding/in FTP folder on the 
transcoder server. It is transcoded and moved to the transcoding/out folder.

6 Media Distribute downloads the transcoded media from the transcoder service.

7 Media Distribute publishes the video package to the specified online video provider.
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• You must configure each transcoding host — for example, Vantage and Carbon Coder. See 
“Configuring the Video Transcoding Host” on page 33.

• You also need to configure an STP profile in the System Settings > Media Distribute section. See 
“Send to Playback Configuration for Media | Distribute” on page 37.

• You must configure the Media Distribute system accounts as described in “Configuring System 
Accounts for Media | Distribute” on page 57.

n If your iNEWS stories use uppercase characters, you can select the option to transform iNEWS 
stories to lowercase. This changes all text to lowercase characters when you load an iNEWS story in 
the Media Distribute layout.

Configuring the Video Transcoding Host

You must configure Windows network share folder structure and folders before using a third-party 
transcoder such as Telestream Vantage® to transcode video for your media package. You also need a 
File Transfer Protocol (FTP) service running on your transcode server. For the FTP process to work, 
each media file function must be mapped to specified folders. The following table describes the 
required structure of the Windows network share folder and FTP folders on a Vantage host server:

The Windows network folder for incoming media must be accessible and mapped to the FTP folder 
(for the transcoded media). This FTP structure is required for retrieving MXF files from Send to 
Playback and for providing the transcoded output for Media Distribute workflows.

You also need to set the Interplay Transfer Manager options in the Send to Playback configuration for 
Media Distribute. For information on configuring Send to Playback, see “Send to Playback 
Configuration for Media | Distribute” on page 37.

To configure your FTP service, you need to install an FTP server application. The procedure in this 
section uses the open source FTP server application called FileZilla Server. You can download the 
software from the following Web site: https://filezilla-project.org/.

Windows Network Share FTP Folder

avid ftp://<Vantage_hostname>/transcoding/in 

ftp://<Vantage_hostname>/transcoding/out

ftp://<Vantage-hostname>/transcoding/mixdown

https://filezilla-project.org/
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To set up Windows network share:

1. On your transcoding server, create the following folder if it does not exist already: 
<transcoder_hostname>\<drive:>\avid\transcoding\in

2. Right-click the <transcoder_hostname>\<drive:>\avid folder and select Sharing and Security.

The avid Properties dialog box opens.

3. Click the Sharing tab, and then select the Share this folder option.
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4. Click Permissions.

The Permissions dialog box opens.

5. Select Everyone, and then select Allow for all permissions in the Permissions for Everyone list.

6. Click OK to return to the avid Properties dialog box, and then click OK.

7. Open FileZilla Server, and log in to your server.

8. Select Edit > Users.

The Users dialog box opens.
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9. Click Add.

The Add User Account dialog box opens.

10. In the text box, type avid, and then click OK.

11. In the Users dialog box, select the following options:

- Enable account

- Password, and type a password for the user account

- Bypass userlimit of server

12. In the Page list, select Shared folders.

13. In the Shared folders area, click Add, and then navigate to the <drive:>\avid folder, and then 
click OK.

The folder is added to the Shared folders list.
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14. Select the following options for Files and Directories:

- Read

- Write

- Delete

- Append

- Create

- Delete

- List

- +Subdirs

15. Click OK.

Send to Playback Configuration for Media | Distribute

The MediaCentral UX administrator needs to specify Send to Playback configuration information 
before you can use publish using Media Distribute. The Transfer Manager Destination Profile must 
be the same as the profile name specified in the Interplay Transfer settings. The FTP host name, user 
name, and password also reflect the same settings in Interplay Transfer.

The send-to-playback operation uses the credentials of the MediaCentral UX workgroup user 
specified in the Interplay profile and not the currently logged in user, so the user must have read/write 
privileges for the Interplay database used for sending media assets to the FTP host. For information 
on setting up MediaCentral UX users and roles, see “Managing Users and Groups” in the Avid 
MediaCentral | UX Administration Guide.

n You can create only one Send to Playback configuration for each Media Distribute installation.

To configure Send to Playback publish settings:

1. Sign in to MediaCentral UX as an administrator.

2. Select System Settings from the Layout selector. 

The System Settings layout opens.



Configuring the Transcode Route

38

3. In the Settings pane select Media Distribute > Profiles.

The Settings pane displays the settings in that group.

4. Click the Publication Type menu and select STP.

5. Click the + (plus) button in the Details section.

An STP profile named “New Profile” is created in the Details section.

6. Specify the required settings:

- Profile Name: use the same name used for the FTP server profile configured in the Interplay 
Transfer Configuration tool. For more information, see “Configuring an FTP Server Profile” 
in the Interplay | Transfer Setup and User’s Guide.

- Target VCID: Select a VCID from the list of supported resolutions.

n AVC Long GOP formats are not supported with Media Distrubute.

- Audio: Options are Direct, Stereo, or Mono. When you use Direct to send a export a clip for 
Send to Playback, the channel order reflects the channel order used when you captured the 
audio. For example, if your source audio is 5:1 multichannel audio, you should select Direct 
to preserve the channel mappings.

- Audio Bit Depth: Options are 16 and 24.

- Audio Target Sample Rate: Options are 32000, 44100, 48000, and 96000.
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- Shared ISIS Workspace — The STP service requires this Avid shared storage workspace to 
store video prior to delivery to the transcode service. Select a valid shared workspace from 
the menu to be used as a temporary location for storing media.

n The user specified in this profile must have read/write privileges for the shared storage workspace.

- Transfer Manager Host — select a Transfer Manager host from the menu. You can use the 
values from your Transfer Manager configuration. For more information, see the 
Interplay | Transfer Setup and User's Guide.

- Transfer Manager Destination Profile — Select an existing destination profile from the 
menu.

- TransferManager Profile Type — Select a profile from the following options:

- Mixing Down FTP Host — Type the FTP host name. The FTP host name must be the same 
as the FTP server name associated with the destination profile and specified in the FTP 
configuration in Interplay Transfer. For more information on FTP configuration in Interplay 
Transfer, see Interplay | Transfer Setup and User's Guide. 

In the sample profile setting above, the Transfer Manager Destination Profile is listed as 
xdcamhd1080i50 and the Mixing Down FTP Host is xxx-srmonia. This corresponds to the 
following components of the Interplay Transfer FTP configuration:

Profile Type Description

IFrame For send-to-playback operations using I-frame media. The source media clips must 
match the target VCID format. The output file uses an OP1a format.

IFrameAMS For send-to-playback operations using I-frame media and sent to an Avid AirSpeed 
server. The source media clips must match the target VCID format. The output file 
uses an OP Atom format.

LongGoP For send-to-playback operations using Long GOP media. Since the 
send-top-playback encoding creates a new media clip, the source media clips do 
not need to match the target VCID format. The output file uses an OP1a format.

LongGoPAMS For send-to-playback operations using Long GOP media and sent to an Avid 
AirSpeed server. Since the send-top-playback encoding creates a new media clip, 
the source media clips do not need to match the target VCID format. The output 
file uses an OP Atom format.
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- Mixing Down FTP Path — Type the path to the FTP destination where MXF output is 
staged for transcode. This should be the same as the destination directory specified in the 
FTP configuration in Interplay Transfer. In the example here, the Mixing Down FTP Path is 
/transcoding/mixdown.

c Do not set the Mixing Down FTP Path to the same delivery folders used by your third-party 
transcoding application — for example, the FTP Transcode/in Path in your Vantage profile. 
The FTP location must be independent of the transcoder path. 

- Mixing Down FTP Username — Type the user name for your FTP service credentials.

- Mixing Down FTP Password — Type the password for your FTP service credentials.

n You cannot use either an at sign (@) or a colon (:) in your password. You can substitute %40 (@) or 
%3a (:) instead.

7. Click Verify Profile Settings to validate the profile settings.

If your profile is valid, a message displays: “Profile configurations is valid.” If any settings are 
incorrect, a message displays and indicates which fields are incorrect. All invalid settings names 
change to red. 

8. Click Apply to save the profile. 

The profile displays in the Details section with the new information.

If you are editing a profile, click Revert to return to the original settings. If you want to delete a 
profile, select the profile and click the minus (-) button in the Details section.

Configuring a Telestream Vantage Profile

Before you can use the Telestream Vantage video transcoding service with Media Distribute, you 
must install Telestream Vantage on your system and then configure the Vantage settings in 
MediaCentral UX.

Before you set up your Vantage workflow, you must configure your video host transcoding. For more 
information, see “Configuring the Video Transcoding Host” on page 33.

The following procedures assume you have created a Vantage account. For more information, see 
http://www.telestream.net/vantage/.

n You must select your Telestream Vantage video transcoding service profile when you set up your 
system accounts — for example, your YouTube or Vimeo account — for publishing your media 
packages. Depending on your configuration, you might need to configure your system accounts 
before configuring MediaCentral UX for your Vantage account. For more information, see 
“Configuring System Accounts for Media | Distribute” on page 57.

To install and configure Telestream Vantage:

1. Install Vantage on your Windows system.

2. Use the Vantage Management Console to configure your Vantage license.

3. Configure your Vantage workflow, and then edit your Flip tasks to set the output folder to the 
\\<hostname>\avid\transcoding\out folder you created when you set up your video host 
transcoding. A typical Vantage workflow usually includes at least a Receive and a Flip task. See 
your Vantage documentation for more information on creating and configuring workflows.

http://www.telestream.net/vantage/
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4. Make sure that you select H.264 as the Encoder and .mp4 as the Extension in your Flip tasks.

n You cannot change the output file name by adding file name prefixes or suffixes. This causes the 
publish job to fail.

5. Type the following URL in a browser address bar to obtain your Vantage workflow ID: 
http://<hostname>:8676/DomainRest/GetWorkflows.

A Web page displays your Vantage workflow ID.

6. Save your workflow ID.

To configure MediaCentral UX for your Vantage account:

1. Sign in to MediaCentral UX as an administrator.

2. Select System Settings from the Layout selector. 

The System Settings layout opens.

3. In the Settings pane select Media Distribute > Profiles.

The Settings pane displays the settings in that group.

4. Click the Publication Type menu and select Vantage.

5. Click the + (plus) button in the Details section.

A Vantage profile named “New Profile” is created in the Details section.
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6. Specify the required settings, using the configuration on your Vantage system:

- Profile Name (type a descriptive name for your profile)

- Workflow ID (from your Vantage workflow configuration)

- Host Name (your Vantage hostname — for example, vantage-host)

- FTP Hostname (optional — if you use different servers for your FTP transcode in/out 
location and for your File Share path, you can specify a different FTP server. If the transcode 
in/out and File Share are on the same server, you can leave this setting blank.)

- FTP User Name (from your video host transcoding configuration)

- FTP Password (from your video host transcoding configuration)

- FTP Transcode/In Path (for incoming files, from your video host transcoding configuration. 
You can use a subpath expression — for example, transcoding/in.)

- FTP Transcode/Out Path (for outgoing files, from your video host transcoding configuration. 
You can use a subpath expression — for example, transcoding/out.)

- File Share In Path (from your video host transcoding configuration — see “Configuring the 
Video Transcoding Host” on page 33. You must use the path to the Network Share path for 
this setting — for example, \\my_vantage\avid.)

7. Click Verify Profile Settings to validate the profile settings.

If your profile is valid, a message displays: “Profile configurations is valid.” If any settings are 
incorrect, a message displays and indicates which fields are incorrect. All invalid settings names 
change to red. 

8. (Optional) If your iNEWS stories use uppercase characters, you can select the option to 
transform iNEWS stories to lowercase. This changes all text to lowercase characters when you 
load an iNEWS story in the Media Distribute layout.

9. Click Apply to save the profile. 

The profile displays in the Details section with the new information.

If you are editing a profile, click Revert to return to the original settings. If you want to delete a 
profile, select the profile and click the minus (-) button in the Details section.

Validating the Vantage Transcode Route Configuration

When you have configured video transcoding for your Vantage video host system as well as the 
Telestream Vantage profile, you can validate the configuration by publishing a test media package to 
make sure all components work successfully. For information on configuring video transcoding and 
the Vantage profile, see “Configuring the Video Transcoding Host” on page 33 and “Configuring a 
Telestream Vantage Profile” on page 40.

n To publish a media package, you first need to set up and configure at least one system account. For 
more information, see “Configuring System Accounts for Media | Distribute” on page 57.

The validation procedure includes monitoring the progress of the transcode procedure in the 
following applications:

• the ServiceMix log in your MediaCentral server

• the Job Status tab of the Vantage Workflow Designer

• the Vantage server Avid transcode folders

• the Media Distribute layout in MediaCentral UX



Configuring the Transcode Route

43

To validate the Vantage transcode configuration:

1. Log in to the MediaCentral server, either locally or using a terminal emulator application such as 
PuTTY, and type the following in a terminal window:

a. To open the ServiceMix application, type the following command: 
ssh Administrator@localhost -p 8101

b. Type yes to continue connecting to the host, and then type the default password avid.

The ServiceMix interface displays in the terminal window.

c. To move to the end of the log, type log:tail, and press Enter.

2. On your Vantage server, do the following:

a. Open Vantage Workflow Designer, and then select File > Job Status.

b. In a file browser, navigate to <drive>:/avid/transcoding so you can see the following folders:

- <drive>:/avid/transcoding/in

- <drive>:/avid/transcoding/out

3. Sign in to MediaCentral UX, and then click the Layout selector and select Media Distribute.

The Media Distribute layout opens.

4. Click the Social Message pane.

The Social Message pane opens.

5. Add some text in the Message text box.

Changes you make in the Message text box apply globally to all social media targets you select. 
You can also modify the story text for individual targets in the text boxes for those targets.

6. Select a social media target — for example, YouTube.

7. Click the Profiles menu, and select the Vantage transcoding service profile.

8. Double-click a video asset in the Asset pane or drag the video asset to the Media viewer.

The video asset displays in the Media pane. You can select a master clip, a subclip, or a 
sequence.
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9. Click Attach Video.

The video displays in the Video area of the Social Media pane. 

10. Click Post, and then click Yes.
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11. Click the Packages pane, and then click the Refresh button.

The Packages pane displays the media package status as Pending.

12. Click Publish.

The Packages pane displays the media package status as Mixing Down. When the mixdown 
process completes, the status displays as Mixing Down Finished.

13. In the ServiceMix console displaying in the MediaCentral server terminal window, check the log 
for the following entries:

- Transcoded MediaItem is found transcodedMediaItemID=<ID number>

- Starting to copy MXF <media object ID> to transcoder machine FTP <Vantage_hostname>

n When the media package is published, the ServiceMix log displays the transcoded media item as 
released.
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14. In the file browser on the Vantage server, check the <drive>:/avid/transcoding/in folder for the 
MXF media file to be transcoded.

n When the media package is published, the transcoded media item is deleted from the transcoding/in 
and transcoding/out folders.

15. In the Job Status tab of the Vantage Workflow Designer, check the status of the transcode job.

16. When the Job Status tab reports the transcode process as completed, check the 
<drive>:/avid/transcoding/out folder in the file browser for the transcoded MXF media file.
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17. In the MediaCentral UX Packages pane, check the status of the media package.

When the publish procedure completes, the status displays as Published and the link to video 
included in the package appears in blue. Clicking the link opens a browser and displays the video 
on the Web page for the selected online platform.

Configuring the Harmonic ProMedia Carbon Transcoder

Before you can use the Harmonic ProMedia™ Carbon transcoder with Media Distribute, you must 
install ProMedia Carbon on your system and then configure the CarbonCoder settings in 
MediaCentral UX.

Before you set up your Carbon system, you must configure your video host transcoding. For more 
information, see “Configuring the Video Transcoding Host” on page 33.

The following procedures assume you have created a ProMedia Carbon account. For more 
information, see http://www.harmonicinc.com/product/promedia-carbon.

To install and configure ProMedia Carbon:

1. Install Harmonic ProMedia Carbon on your Windows system.

2. Start ProMedia Carbon.

3. In Carbon, create a new profile by doing the following:

a. In the Target tab, add a new target and select a target preset.

b. In the Target Parameters window, modify the Destination Base Name to %s and the 
Destination Path to \\hostname\avid\transcoding\out.

c. Click Save Profile, and name the new profile Avid MPD.

4. Locate the profile ID by using one of the following:

t The Preset Editor in Carbon Admin

t ListProfiles.exe in the Carbon SDK

http://www.harmonicinc.com/product/promedia-carbon
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To configure MediaCentral UX for your ProMedia Carbon account:

1. Sign in to MediaCentral UX as an administrator.

2. Select System Settings from the Layout selector. 

The System Settings layout opens.

3. In the Settings pane select Media Distribute > Profiles.

The Settings pane displays the settings in that group.

4. Click the Publication Type menu and select CarbonCoder.

5. Click the + (plus) button in the Details section.

A CarbonCoder profile named “New Profile” is created in the Details section.

6. Specify the required settings, using the using the parameter fields from ProMedia Carbon:

- Profile Name (type a descriptive name for your profile)

- Workflow ID (from your CarbonCoder profile)

- Host Name (your CarbonCoder hostname — for example, carboncoder-host)

- FTP Hostname (optional — if you use different servers for your FTP transcode in/out 
location and for your File Share path, you can specify a different FTP server. If the transcode 
in/out and File Share are on the same server, you can leave this setting blank.)

- FTP User Name (from your video host transcoding configuration)

- FTP Password (from your video host transcoding configuration)

- FTP Transcode/In Path (for incoming files, from your video host transcoding configuration)
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- FTP Transcode/Out Path (for outgoing files, from your video host transcoding 
configuration)

- File Share In Path (from your video host transcoding configuration — see “Configuring the 
Video Transcoding Host” on page 33)

7. Click Verify Profile Settings to validate the profile settings.

If your profile is valid, a message displays: “Profile configurations is valid.” If any settings are 
incorrect, a message displays and indicates which fields are incorrect. All invalid settings names 
change to red. 

8. (Optional) If your iNEWS stories use uppercase characters, you can select the option to 
transform iNEWS stories to lowercase. This changes all text to lowercase characters when you 
load an iNEWS story in the Media Distribute layout.

9. Click Apply to save the profile. 

The profile displays in the Details section with the new information.

If you are editing a profile, click Revert to return to the original settings. If you want to delete a 
profile, select the profile and click the minus (-) button in the Details section.

Configuring a RadiantGrid Profile

In order to use the RadiantGrid™ transcoding engine with Media Distribute, you need to install and 
configure the RadiantGrid software on a supported server. See your RadiantGrid representative for 
more information.

The following procedures assume you have created a RadiantGrid account and password. For more 
information, see http://www.wohler.com/RgProduct.aspx.

Once you have your RadiantGrid profile credentials, you need to create new transcode profile. This 
profile must transcode media from the MXF format to the H.264 (.mp4) format. The following 
procedure does not describe all of the options required for creating the profile using the RadiantGrid 
application.
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To set up a RadiantGrid profile for use with Media Distribute:

1. Open your browser and log in to your RadiantGrid account.

2. Create a new Transcode profile. For details on creating a RadiantGrid transcoding profile, see 
your RadiantGrid documentation.

3. (Optional) Configure a workflow template.

n If you create a new transcode profile, you might be able to skip this step. However, if you use an 
existing transcode profile, you might need to reconfigure your workflow template.

4. Configure an FTP service. For information on configuring the FTP service, see “Configuring the 
Video Transcoding Host” on page 33.
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To configure MediaCentral UX for your RadiantGrid account:

1. Sign in to MediaCentral UX as an administrator.

2. Select System Settings from the Layout selector. 

The System Settings layout opens.

3. In the Settings pane select Media Distribute > Profiles.

The Settings pane displays the settings in that group.

4. Click the Publication Type menu and select RadiantGrid.

5. Click the + (plus) button in the Details section.

A RadiantGrid profile named “New Profile” is created in the Details section.

6. Specify the required settings, using the configuration on your RadiantGrid system and your FTP 
configuration:

- Profile Name (type a descriptive name for your profile)

- RadiantGrid User Name (from your RadiantGrid configuration)

- RadiantGrid Password (from your RadiantGrid configuration)

- Transcoding Profile Name (the profile name is listed on the Workflow > Transcode Web 
page of your RadiantGrid configuration)

- Host Name (your RadiantGrid server hostname — for example, radiant-host)
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- FTP Hostname (optional — if you use different servers for your FTP transcode in/out 
location and for your File Share path, you can specify a different FTP server. If the transcode 
in/out and File Share are on the same server, you can leave this setting blank.)

- FTP User Name (from your video host transcoding configuration)

- FTP Password (from your video host transcoding configuration)

- FTP Transcode/In Path (for incoming files, from your video host transcoding configuration)

- FTP Transcode/Out Path (for outgoing files, from your video host transcoding 
configuration)

- File Share In Path (from your video host transcoding configuration)

- File Share Out Path (from your video host transcoding configuration)

7. Click Verify Profile Settings to validate the profile settings.

If your profile is valid, a message displays: “Profile configurations is valid.” If any settings are 
incorrect, a message displays and indicates which fields are incorrect. All invalid settings names 
change to red. 

8. (Optional) If your iNEWS stories use uppercase characters, you can select the option to 
transform iNEWS stories to lowercase. This changes all text to lowercase characters when you 
load an iNEWS story in the Media Distribute layout.

9. Click Apply to save the profile.

The profile displays in the Details section with the new information.

If you are editing a profile, click Revert to return to the original settings. If you want to delete a 
profile, select the profile and click the minus (-) button in the Details section.

Configuring a MAM Profile

Starting with Media Distribute v2.7, you can publish media packages using assets stored in Interplay 
Media Asset Management (MAM) databases. If your configuration includes a MAM system, you can 
create a MAM profile for Media Distribute to the following platforms:

• Amazon S3

• Facebook

• Flickr

• Twitter

• Vimeo

• YouTube

Your MAM configuration provides you with the following information needed to complete your 
MediaCentral UX configuration:

• MAM Process Name (defined by your MAM workflow; the default is MEDIA_DISTRIBUTE)

• Service Realm (listed in the MediaCentral UX System Settings for Interplay MAM)

• Output FTP Hostname (the name of the FTP server accessible from MAM and from MCS 
systems)

• Output FTP Path (the path to the FTP server accessible from MAM and from MCS and Media 
Distribute systems)
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• Output FTP User Name (the user name associated with the FTP server)

• Output FTP Password (the user password associated with the FTP user)

Configuring the FTP site allows Media Distribute to acquire assets from Interplay MAM and publish 
them to the selected platform. For information on configuring Interplay MAM for Media Distribute, 
see the Interplay | MAM Media Distribution Process Reference, part of the Interplay MAM 
documentation that comes with Interplay MAM.

To configure MediaCentral UX for your MAM database:

1. Sign in to MediaCentral UX as an administrator.

2. Select System Settings from the Layout selector. 

The System Settings layout opens.

3. In the Settings pane select Media Distribute > Profiles.

The Settings pane displays the settings in that group.

4. Click the Publication Type menu and select MAM.

5. Click the + (plus) button in the Details section.

A MAM profile named “New Profile” is created in the Details section.
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6. Specify the required settings, using the configuration on your AAF system and your FTP 
configuration:

- Profile Name: Type a descriptive name for your profile.

- MAM Process Name: Type the process name specified by your MAM configuration; the 
default is MEDIA_DISTRIBUTIOIN.

n The MAM Process Name is case-sensitive.

- Service Realm: Type the name of the service realm associated with your MAM 
configuration. The MAM service realm is listed as the Bus Realm in the MediaCentral UX 
System Settings for Interplay MAM.

- MAM Video Output Format: Use a format from the list. The options are MOV, MP4, MXF.

- MAM Image Output Format: Use a format from the list. The options are JPEG and PNG.

- Output FTP Hostname: Type the name of the FTP server accessible from MAM and from 
MCS systems. This can be the same server listed as the Server Name in the System 
Connection section of the MediaCentral UX System Settings for Interplay MAM.

- Output FTP Path (the path to the FTP server accessible from MAM and from MCS and 
Media Distribute systems)

- Output FTP User Name (the user name associated with the FTP server)

- Output FTP Password (the user password associated with the FTP user)

7. Click Apply to save the profile.

The profile displays in the Details section with the new information.

If you are editing a profile, click Revert to return to the original settings. If you want to delete a 
profile, select the profile and click the minus (-) button in the Details section.
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Configuring an E-mail Profile

If you use the Distribution pane to publish media packages, you can configure an e-mail profile to 
send e-mail notifications to one or more users when a package is published. The e-mail profile uses 
the e-mail information configured for MediaCentral UX in the Messages & Sharing panel of the 
System Settings to send the e-mail.

For information on using the Distribution pane, see “Publishing MediaCentral Assets with the 
Distribution Pane” in the Media | Distribute User’s Guide. For information about configuring e-mail 
settings in MediaCentral UX, see “Configuring E-Mail Forwarding” in the Avid MediaCentral | UX 
Administration Guide. 

To configure e-mail notifications:

1. Sign in to MediaCentral UX as an administrator.

2. Select System Settings from the Layout selector. 

The System Settings layout opens.

3. In the Settings pane select Messages & Sharing.

The Settings pane displays the settings in that group.

4. Make sure E-mail Forwarding has been configured for your MediaCentral environment. If it has 
not been configured, see the Avid MediaCentral | UX Administration Guide for information on 
configuring e-mail settings.
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5. In the Settings pane select Media Distribute > Profiles.

The Settings pane displays the settings in that group.

6. Click the Publication Type menu and select E-mail.

7. Click the + (plus) button in the Details section.

An E-mail profile named “New Profile” is created in the Details section.

8. Specify the required settings:

- Profile Name: Type a descriptive name for your profile)

- Recipients: Type the e-mail address of any user you want to receive notifications. Multiple 
e-mail addresses must be separated by a semicolon (;).

9. Select Send If Publication Fails if you want to receive e-mail notifications when publication fails 
to complete.

10. Click Verify Profile Settings to validate the profile settings.

If your profile is valid, a message displays: “Profile configurations is valid.” If any settings are 
incorrect, a message displays and indicates which fields are incorrect. All invalid settings names 
change to red. 

11. Click Apply to save the profile.

The profile displays in the Details section with the new information.

If you are editing a profile, click Revert to return to the original settings. If you want to delete a 
profile, select the profile and click the minus (-) button in the Details section.



3 Configuring System Accounts for 
Media | Distribute

You can set up multiple accounts in the System Settings layout for the services you want to use for 
publishing to multiple platforms. For information on the supported system accounts, see the 
following topics:

• “Configuring the Bitly Link-Shortening Service” on page 57

• “Configuring a Twitter Publication Account” on page 59

• “Configuring a Facebook Publication Account” on page 63

• “Configuring a Facebook Page Publication Account” on page 68

• “Configuring a Vimeo Publication Account” on page 73

• “Configuring a Vimeo V3 Publication Account” on page 77

• “Configuring a YouTube Publication Account” on page 79

• “Configuring a YouTube v3 Publication Account” on page 84

• “Configuring a Brightcove Account” on page 87

• “Configuring a Kaltura Account” on page 89

• “Configuring an Ooyala Account” on page 91

• “Configuring a Flickr Account” on page 92

• “Configuring an Atex Polopoly Web CMS Account” on page 96

• “Configuring a WorldNow Web CMS Profile” on page 98

• “Configuring thePlatform Profile” on page 102

• “Configuring a WordPress CMS Profile” on page 104

• “Configuring an Amazon S3 Profile” on page 106

• “Configuring a Generic CMS Profile” on page 107

• “Configuring a Generic CMS Extended Profile” on page 111

• “Configuring a NoOpTranscoder Profile” on page 115

• “Configuring a Generic OVP Profile” on page 116

n If your iNEWS stories use uppercase characters, you can select the option in the Media Distribute > 
General section of the System Settings to transform iNEWS stories to lowercase. This changes all text 
to lowercase characters when you load an iNEWS story in the Media Distribute layout.

Configuring the Bitly Link-Shortening Service
You can configure the Bitly™ URL shortening service using MediaCentral UX settings. Using a link 
shortening service is optional, but it can aid in ensuring that URLs do not exceed character limits on 
some social media postings.
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The following procedures assume you have created a Bitly account at https://bitly.com/ and you have 
generated a Bitly API key at http://dev.bitly.com/.

To configure Bitly for Media Distribute:

1. Sign in to MediaCentral UX as an administrator.

2. Select System Settings from the Layout selector. 

The System Settings layout opens.

3. In the Settings pane select Media Distribute > Profiles.

The Settings pane displays the settings in that group.

4. Click the Publication Type menu and select Bitly.

5. Click the + (plus) button in the Details section.

A Bitly profile named “New Profile” is created in the Details section.

6. Specify the required settings:

- Profile Name (type a descriptive name for your profile)

- Login

- API Key

7. Click Verify Profile Settings to validate the profile settings.

If your profile is valid, a message displays: “Profile configurations is valid.” If any settings are 
incorrect, a message displays and indicates which fields are incorrect. All invalid settings names 
change to red. 

n The setting, “Transform iNEWS stories to lower case,” applies only to Media Distribute accounts 
that publish packages containing iNEWS stories. The option does not affect this setting.

https://bitly.com/
http://dev.bitly.com/
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8. Click Apply to save the profile. 

The profile displays in the Details section with the new information.

If you are editing a profile, click Revert to return to the original settings. If you want to delete a 
profile, select the profile and click the minus (-) button in the Details section.

Configuring a Twitter Publication Account
Before you can publish a package to Twitter from MediaCentral UX using Media Distribute, you 
must first set up a Twitter account to which you want to publish, and you must configure a Twitter 
publication account.

This section describes configuring corporate or group house accounts. When you publish to these 
accounts, your packages require review and approval For information on configuring a personal 
account, see “Configuring a User Profile for a Personal Twitter Account” on page 129.

The following procedures assume you have created a Twitter account at https://twitter.com.

n The user interface for Twitter might change without notice. The procedure below outlines the general 
steps to create the elements needed to configure Media Distribute. For more information on creating 
a Twitter application, see your Twitter account documentation.

To set up a Twitter application account for MediaCentral UX multi-platform delivery:

1. Log on to your Twitter account and navigate to the My Applications Web page at 
https://dev.twitter.com/apps.

2. Click Create New App.

The Create an application Web page opens.

https://twitter.com/
https://dev.twitter.com/apps
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3. Type your information for the required fields, which might include the following:

- Name

- Description

- Website (the public URL for your Twitter application, where users can download your 
application or get more information about it; use a placeholder URL if you do not have an 
application URL yet)

4. In the Developer Agreement section, read the rules agreement and select Yes, I agree.

5. If required, type the security text.

6. Click Create your Twitter application.

Your Twitter application opens in the Application Management page.

7. Click the Permissions tab.

The Permissions tab opens.

8. In the Access area, select Read, Write and Access direct messages, and then click Update this 
Twitter application’s settings.

Your settings are saved.
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9. Click the Keys and Access Tokens tab.

The Keys and Access Tokens tab opens.

10. In the Application Settings area, click Create Consumer Key and Secret.

n If you already created an access token, the button in this area is labeled “Recreate Consumer Key 
and Secret.”

11. In the Your Access Token area, click Create My Access Token and Token Secret.

n If you already created an access token, the button in this area is labeled “Recreate My Access Token 
and Token Secret.”
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12. Save the following parameter fields so you can enter them in the appropriate location in the 
MediaCentral UX settings:

- Consumer key

- Consumer secret

- Access token

- Access token secret

To configure MediaCentral UX for your Twitter application:

1. Sign in to MediaCentral UX as an administrator.

2. Select System Settings from the Layout selector. 

The System Settings layout opens.

3. In the Settings pane select Media Distribute > Profiles.

The Settings pane displays the settings in that group.

4. Click the Publication Type menu and select Twitter.

5. Click the + (plus) button in the Details section.

A Twitter profile named “New Profile” is created in the Details section.

6. Specify the required settings, using the parameter fields you copied from your Twitter 
application Web page:

- Profile Name (type a descriptive name for your profile)

- Access Token

- Access Secret
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- Consumer Key

- Consumer Secret

7. Click Verify Profile Settings to validate the profile settings.

If your profile is valid, a message displays: “Profile configurations is valid.” If any settings are 
incorrect, a message displays and indicates which fields are incorrect. All invalid settings names 
change to red. 

8. Click Apply to save the profile. 

The profile displays in the Details section with the new information.

If you are editing a profile, click Revert to return to the original settings. If you want to delete a 
profile, select the profile and click the minus (-) button in the Details section. 

n You can add multiple Twitter profiles.

Configuring a Facebook Publication Account
Before you can publish a package to Facebook from MediaCentral UX using Media Distribute, you 
must first set up a Facebook profile account to which you want to publish, and you must configure a 
Facebook publication account in MediaCentral UX. You also need to set permissions for your 
Facebook application so it can post to your Facebook account.

This section describes configuring corporate or group house accounts. When you publish to these 
accounts, your packages require review and approval For information on configuring a personal 
account, see “Configuring a User Profile for a Personal Facebook Account” on page 121.

n Before you attempt to publish your package to Facebook, Avid recommends that you test your 
account privileges.

The following procedures assume you have created a Facebook account at 
https://www.facebook.com.

n The user interface for Facebook developers might change without notice. The procedure below 
provides general guidelines to create the elements needed to configure Media Distribute. For more 
information on creating a Facebook application, downloading and installing any necessary SDK 
applications, see Facebook support documentation.

To set up a Facebook application account for MediaCentral UX multi-platform delivery:

1. Log on to your Facebook account, and then go to the Facebook developers Web page at 
https://developers.facebook.com.

2. If you have not registered as a Facebook developer, do the following: 

a. Click Apps and select Register as a Developer.

The Register as a Facebook Developer dialog box opens.

b. Follow the prompts to register as a Facebook developer.

3. Click Apps, and select Create New App.

n If you previously created an app for Facebook, select My Apps > Add a New App.

The Create New App dialog box opens.

https://www.facebook.com
https://developers.facebook.com/
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4. Select a platform for your app — for example, Android.

5. Type a name for your application in the App Name text box, and then click Create New 
Facebook App ID.

The Create New App ID dialog box opens.

6. Select the appropriate options and then click Create App ID.

7. Click Skip Quick Start.

The Facebook app Dashboard opens.

8. Click Settings.

9. Click Add Platform, and then select Website.

The Settings dialog box opens.

10. In the Website area, type a site URL.

n If you do not have a site URL, you can type http://localhost. You can modify the URL later.

11. Click Save Changes.

12. In the Contact Email text box, type an appropriate e-mail address. The contact e-mail address is 
necessary to activate the app.

13. Save the following parameter fields so you can enter them in the appropriate location in the 
MediaCentral UX settings:

- App ID

- App Secret
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To set Facebook permissions for your Media Distribute application:

1. Log on to your Facebook developers account, and click Tools > Graph API Explorer.

The Graph API Explorer Web page displays.

2. Click the Application menu and select your Facebook application.

3. Click the Get Token menu, and then select Get Access Token.

The Select Permissions dialog box opens.

4. Click the User Data Permissions tab, and then select the user_friends, user_photos, and 
user_videos options.
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5. Click the Extended Permissions tab, and then select the manage_pages, publish_actions, and 
publish_pages options.

6. Click Get Access Token.

The Web page generates a new access token and sets the necessary permissions for your 
application.

n This token remains valid for only one hour.

7. Save your access token so you can enter it in the appropriate location in the MediaCentral UX 
setting.

To make your app available to available to be viewed by the public:

1. Log on to your Facebook developers account, click My Apps, and select your app.

The Dashboard page for your app opens.

2. Click App Review.

3. In the Status tab, click Yes to activate your app.

To configure MediaCentral UX for your Facebook application:

1. Sign in to MediaCentral UX as an administrator.

2. Select System Settings from the Layout selector. 

The System Settings layout opens.



Configuring a Facebook Publication Account

67

3. In the Settings pane select Media Distribute > Profiles.

The Settings pane displays the settings in that group.

4. Click the Publication Type menu and select Facebook.

5. Click the + (plus) button in the Details section.

A Facebook profile named “New Profile” is created in the Details section.

6. Specify the required settings, using the parameter fields you copied from your Facebook Apps 
Web page:

- Profile Name (type a descriptive name for your profile — for example, [MyCompany] 
Facebook News)

- FB Profile ID

- Application ID

- Application Secret

- Access Token

- (Optional) Album ID

n You can specify the name of a Facebook album if you want to publish images directly to an album that 
you have created for your Facebook account.
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7. (Optional) Click Transcoding Profile and select one of the available profiles.

n You cannot publish video directly to Facebook unless you specify a transcoding profile.

8. (Optional) Click Get Expiration Date.

Media Distribute checks the expiration date of your access token and updates the entry in the 
Expiration Date field. This shows you how much time is left on your Facebook access token.

9. (Optional) Click Get Long-Term Token.

Media Distribute converts your access token, which often remains valid for a couple of hours, to 
a long-lived token. For more information on short-lived and long-lived tokens and their 
expiration periods, see your Facebook developer documentation.

10. Click Verify Profile Settings to validate the profile settings.

If your profile is valid, a message displays: “Profile configurations is valid.” If any settings are 
incorrect, a message displays and indicates which fields are incorrect. All invalid settings names 
change to red. 

11. Click Apply to save the profile. 

The profile displays in the Details section with the new information.

If you are editing a profile, click Revert to return to the original settings. If you want to delete a 
profile, select the profile and click the minus (-) button in the Details section.

n You can add multiple Facebook profiles.

Configuring a Facebook Page Publication Account
You can publish packages to a corporate Facebook Page account from MediaCentral UX using Media 
Distribute. Once you set up a Page account on Facebook, you then can configure a Facebook Page 
publication account.

Facebook Pages allow businesses to connect with customers and users. Facebook Page accounts 
allow official representatives of a business or organization to create and contribute to Pages. For more 
information on Facebook Pages, see Facebook Pages support information at 
www.facebook.com/help.

You do not need to configure a Facebook publication account in Media Distribute in order to publish 
to your Facebook Page, but you do need to have a Facebook account to set up a Facebook Page. For 
information on configuring a Facebook publication account, see “Configuring a Facebook 
Publication Account” on page 63.

n Before you attempt to publish your package to a Facebook Page, Avid recommends that you test your 
account privileges.

The following procedures assume you have created a Facebook account and created a Facebook Page 
at https://www.facebook.com/pages/create.

n The user interface for Facebook developers might change without notice. The procedure below 
provides general guidelines to create the elements needed to configure Media Distribute. For more 
information on creating a Facebook application, see Facebook support documentation.

https://www.facebook.com/help/
https://www.facebook.com/pages/create


Configuring a Facebook Page Publication Account

69

To set up a Facebook Page for MediaCentral UX multi-platform delivery:

1. Log on to your Facebook account, click the Edit Account button, and select Manage Pages.

The Pages page opens.

2. Click your Page in the Pages list.

Your Facebook Page opens.

3. Click About, and then select Page Info.

Your Facebook Page displays the page information.

4. Save your Facebook Page ID so you can enter it in the appropriate location in the MediaCentral 
UX setting.

To set Facebook Page permissions for your Media Distribute application:

1. Log on to your Facebook developers account, and click Tools & Support > Graph API Explorer.

2. Click the Application menu and select the Facebook application associated with your Facebook 
Page.

The Graph API Explorer Web page displays.
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3. Click the Get Token menu, and then select Get Access Token.

The Select Permissions dialog box opens.

4. Click the User Data Permissions tab, and then select the user_friends, the user_photos, and 
user_videos options.

5. Click the Extended Permissions tab, and then select the manage_pages, publish_actions, and 
publish_pages options.

6. Click Get Access Token.

The Web page generates a new access token and sets the necessary permissions for your 
application.

n This token remains valid for only one hour.

7. Save your access token so you can enter it in the appropriate location in the MediaCentral UX 
setting.
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8. Click Debug.

The Access Token Debugger page opens and displays information about your access token.

9. Save your App ID and User ID so you can enter them in the appropriate locations in the 
MediaCentral UX setting.

10. Select Apps > [your Facebook app].

The Dashboard for your app opens.

11. Click Show to display your App Secret.

12. Save your App Secret so you can enter it in the appropriate locations in the MediaCentral UX 
setting.

To configure MediaCentral UX for your Facebook Page:

1. Sign in to MediaCentral UX as an administrator.

2. Select System Settings from the Layout selector. 

The System Settings layout opens.
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3. In the Settings pane select Media Distribute > Profiles.

The Settings pane displays the settings in that group.

4. Click the Publication Type menu and select FacebookPage.

5. Click the + (plus) button in the Details section.

A FacebookPage profile named “New Profile” is created in the Details section.

6. Specify the required settings, using the parameter fields you copied from your Facebook Page 
Web page:

- Profile Name (type a descriptive name for your profile — for example, [MyCompany] Page)

- FB Profile ID — the Facebook Profile ID of the user who administers your Facebook Page

- FB Page ID — from your Facebook app settings

- Application ID — from your Facebook app settings

- Application Secret — from your Facebook app settings

- Access Token — from your Facebook app settings

- (Optional) Album ID

n You can specify the name of a Facebook album if you want to publish images directly to an album that 
you have created for your Facebook account.
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7. (Optional) Click Transcoding Profile and select one of the available profiles.

n You cannot publish video directly to Facebook unless you specify a transcoding profile.

8. (Optional) Click Get Expiration Date.

Media Distribute checks the expiration date of your access token and updates the entry in the 
Expiration Date field. This shows you how much time is left on your Facebook access token.

9. (Optional) Click Get Long-Term Token.

Media Distribute converts your access token, which often remains valid for a couple of hours, to 
a long-lived token. For more information on short-lived and long-lived tokens and their 
expiration periods, see your Facebook developer documentation.

10. Click Verify Profile Settings to validate the profile settings.

If your profile is valid, a message displays: “Profile configurations is valid.” If any settings are 
incorrect, a message displays and indicates which fields are incorrect. All invalid settings names 
change to red. 

11. Click Apply to save the profile. 

The profile displays in the Details section with the new information.

If you are editing a profile, click Revert to return to the original settings. If you want to delete a 
profile, select the profile and click the minus (-) button in the Details section.

n You can add multiple Facebook page profiles.

Configuring a Vimeo Publication Account
Before you can publish a package to Vimeo from MediaCentral UX using Media Distribute, you 
must first set up a Vimeo account to which you want to publish, and you must configure a Vimeo 
publication account. The configuration requires that you request and receive upload access for you 
app from Vimeo.

n Media Distribute works with both the Advanced API and the standard API used by Vimeo 
applications. For both, you need to check the OAuth tab in the My Apps Web page for the required 
parameters used in configuring your Vimeo account. To use OAuth2 authentication, see “Configuring 
a YouTube v3 Publication Account” on page 84.

The following procedures assume you have created a Vimeo account at https://vimeo.com/.

n The user interface for Vimeo might change without notice. The procedure below outlines the general 
steps to create the elements needed to configure Media Distribute. For more information on creating 
a Vimeo application, see your Vimeo account documentation.

https://vimeo.com/
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To set up a Vimeo application account for MediaCentral UX multi-platform delivery:

1. Log on to your Vimeo account, and then go to the Vimeo My Apps Web page at 
https://developer.vimeo.com/apps.

2. Click “Create a new app.”

The Create an new App Web page opens.

3. Type your information in the required text fields:

- App Name

- App Description

- App URL (the public URL for your Vimeo application, where users can download your 
application or get more information about it; use a placeholder URL if you do not have an 
application URL yet)

4. Accept the Vimeo API License Agreement (https://developer.vimeo.com/guidelines/terms) and 
the Vimeo Terms of Service (https://vimeo.com/terms), and then click Create app.

The My API Apps Web page opens.

https://developer.vimeo.com/apps
https://developer.vimeo.com/guidelines/terms
https://vimeo.com/terms


Configuring a Vimeo Publication Account

75

5. To request upload access, do the following:

a. Click the Basic tab, and in the Upload Access section click Request Upload Access.

The Request Upload Permissions Web page opens.

b. On the Request Upload Permissions page, answer the three questions and then click Request 
Upload Access.

The message, “Requested - Pending decision,” displays. If Vimeo approves the request, the 
My API Apps page for your app displays the approval in the Upload Access section. 
Approval from Vimeo might take up to five business days from the time of the request.

6. Click the OAuth tab, and save the following parameter fields so you can enter them in the 
appropriate location in the MediaCentral UX settings:

- Client ID (Also known as Consumer Key or API Key)

- Client Secret (Also known as Consumer Secret or API Secret)

- Access token

- Access token secret

n By default, Vimeo assigns Read, Write, and Delete permissions for your application.

To configure MediaCentral UX for your Vimeo application:

1. Sign in to MediaCentral UX as an administrator.

2. Select System Settings from the Layout selector. 

The System Settings layout opens.
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3. In the Settings pane select Media Distribute > Profiles.

The Settings pane displays the settings in that group.

4. Click the Publication Type menu and select Vimeo.

5. Click the + (plus) button in the Details section.

A Vimeo profile named “New Profile” is created in the Details section.

6. Specify the required settings, using the parameter fields you copied from your Vimeo My 
Advanced API Apps Web page:

- Profile Name (type a descriptive name for your profile)

- Access Token

- Access Secret

- Consumer Key

- Consumer Secret

7. Click Transcoding Profile and select one of the available profiles.

8. Click Verify Profile Settings to validate the profile settings.

If your profile is valid, a message displays: “Profile configurations is valid.” If any settings are 
incorrect, a message displays and indicates which fields are incorrect. All invalid settings names 
change to red. 

9. Click Apply to save the profile. 

The profile displays in the Details section with the new information.

If you are editing a profile, click Revert to return to the original settings. If you want to delete a 
profile, select the profile and click the minus (-) button in the Details section.
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Configuring a Vimeo V3 Publication Account
Before you can publish a package to Vimeo from MediaCentral UX using Media Distribute, you 
must first set up a Vimeo account to which you want to publish, and you must configure a Vimeo 
publication account. The configuration requires that you request and receive upload access for you 
app from Vimeo.

The Vimeo V3 publication profile uses the V3 API for your Vimeo application. This allows you to 
employ the OAuth2 authentication protocol for your app.

The following procedures assume you have created a Vimeo account at https://vimeo.com/.

n The user interface for Vimeo might change without notice. The procedure below outlines the general 
steps to create the elements needed to configure Media Distribute. For more information on creating 
a Vimeo application, see your Vimeo account documentation.

To set up a Vimeo application account for MediaCentral UX multi-platform delivery:

1. Log on to your Vimeo account, and then go to the Vimeo My Apps Web page at 
https://developer.vimeo.com/apps.

2. Click “Create a new app.”

The Create an new App Web page opens.

3. Type your information in the required text fields:

- App Name

- App Description

- App URL (the public URL for your Vimeo application, where users can download your 
application or get more information about it; use a placeholder URL if you do not have an 
application URL yet)

https://vimeo.com/
https://developer.vimeo.com/apps
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4. Accept the Vimeo API License Agreement (https://developer.vimeo.com/guidelines/terms) and 
the Vimeo Terms of Service (https://vimeo.com/terms), and then click Create app.

The My API Apps Web page opens.

5. Click the OAuth2 tab.

6. To request upload access, do the following:

a. Click the Basic tab, and in the Upload Access section click Request Upload Access.

The Request Upload Permissions Web page opens.

b. On the Request Upload Permissions page, answer the three questions and then click Request 
Upload Access.

The message, “Requested - Pending decision,” displays. If Vimeo approves the request, the 
My API Apps page for your app displays the approval in the Upload Access section. 
Approval from Vimeo might take up to five business days from the time of the request.

7. Click Generate Token, and save the access token value displayed in the Your new Access token 
field so you can enter it in the appropriate location in the MediaCentral UX settings:

n By default, Vimeo assigns Read, Write, and Delete permissions for your application.

To configure MediaCentral UX for your Vimeo V3 application:

1. Sign in to MediaCentral UX as an administrator.

2. Select System Settings from the Layout selector. 

The System Settings layout opens.

https://developer.vimeo.com/guidelines/terms
https://vimeo.com/terms
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3. In the Settings pane select Media Distribute > Profiles.

The Settings pane displays the settings in that group.

4. Click the Publication Type menu and select Vimeo V3.

5. Click the + (plus) button in the Details section.

A Vimeo V3 profile named “New Profile” is created in the Details section.

6. Specify the required settings, using the access token you copied from your Vimeo My Advanced 
API Apps Web page:

- Profile Name (type a descriptive name for your profile)

- Access Token

7. Click Transcoding Profile and select one of the available profiles.

8. Click Verify Profile Settings to validate the profile settings.

If your profile is valid, a message displays: “Profile configurations is valid.” If any settings are 
incorrect, a message displays and indicates which fields are incorrect. All invalid settings names 
change to red. 

9. Click Apply to save the profile. 

The profile displays in the Details section with the new information.

If you are editing a profile, click Revert to return to the original settings. If you want to delete a 
profile, select the profile and click the minus (-) button in the Details section.

Configuring a YouTube Publication Account
Before you can publish a package to YouTube from MediaCentral UX using Media Distribute, you 
must first set up a Google account to manage the publication of your media package to YouTube, and 
you must configure a YouTube publication account in MediaCentral UX.

The following procedures assume you have created a Google account at 
https://accounts.google.com/. 

https://accounts.google.com/
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Google has switched the authorization standard used by YouTube applications to OAuth 2.0. If you 
use a YouTube application created before April 2015 to publish videos to the Web, you can follow 
the procedures in this section. If you want to use OAuth 2.0 credentials or if you want to create a new 
YouTube application, see “Configuring a YouTube v3 Publication Account” on page 84.

n The user interface for YouTube and Google accounts might change without notice. The procedure 
below outlines the general steps to create the elements needed to configure Media Distribute. For 
more information on creating and managing a YouTube application, see your Google developer 
account documentation.

You need to provide the following information to configure your YouTube account for 
Media Distribute:

• Your Google developer account user name and password.

• Your Google project name.

• The server API key.

To create a YouTube application for MediaCentral UX:

1. Log on to your Google account, and then go to the Google Developers Console Web page at 
https://console.developers.google.com/project.

2. Click the name of your existing project.

The Project Dashboard for your project opens.

https://console.developers.google.com/project
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3. In the navigation panel for your project, click Permissions.

The Permissions page opens.

4. Select the user you want to administer the project and the account for your application and select 
the appropriate permissions:

- Is Owner — by default, the user who creates the project is the owner. You can add other 
owners who can change the project settings and manage project members.

- Can edit — these users can modify the project settings.

- Can view — these users can read any project settings or information about the project.

n You can add users clicking the Add Member button.

5. In the APIs & auth section, click Credentials.

The Credentials page opens.

6. Click Add credentials, and then select API key.

The Create a new key dialog box opens.
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7. Click Server key in the Create a new key dialog box.

The Create server API key dialog box opens.

8. (Option) In the Accept Requests from These Server IP Addresses text box, type the name of the 
server used for your Media Distribute applications. This allows you to restrict your API key so 
that requests are only allowed from your servers’ source IP addresses

9. Click Create.

A new API key is created and displays in the Credentials page.

10. If you have never used this account to upload a video, do the following to create a YouTube 
channel:

a. In your browser, navigate to https://www.youtube.com/my_videos.

b. Create a new channel. For information creating a new YouTube channel, see the YouTube 
online help.

To configure MediaCentral UX for your YouTube application:

1. Sign in to MediaCentral UX as an administrator.

2. Select System Settings from the Layout selector. 

The System Settings layout opens.

https://www.youtube.com/my_videos
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3. In the Settings pane select Media Distribute > Profiles.

The Settings pane displays the settings in that group.

4. Click the Publication Type menu and select YouTube.

5. Click the + (plus) button in the Details section.

A YouTube profile named “New Profile” is created in the Details section.

6. Specify the required settings, using the parameter fields you copied from your YouTube Product 
Dashboard Web page as well as your YouTube credentials:

- Profile Name (type a descriptive name for your profile)

- Application Name (from your Google Developer Console project)

- Developer Key (the API key from your Google Developer Console project)

- User Name

- Password

7. Click Transcoding Profile and select one of the available profiles.

8. Click Verify Profile Settings to validate the profile settings.

If your profile is valid, a message displays: “Profile configurations is valid.” If any settings are 
incorrect, a message displays and indicates which fields are incorrect. All invalid settings names 
change to red. 

n Due to security settings on Google accounts, you might receive an error indicating an incorrect user 
name or password, even if your account credentials are correct. You can sign in to your Google 
account and change the Sign-in and Security settings to enable access to the account for less secure 
apps. For more information, see the Google Accounts Help.
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9. Click Apply to save the profile. 

The profile displays in the Details section with the new information.

If you are editing a profile, click Revert to return to the original settings. If you want to delete a 
profile, select the profile and click the minus (-) button in the Details section.

Configuring a YouTube v3 Publication Account
Before you can publish a package to YouTube from MediaCentral UX using Media Distribute, you 
must first set up a Google account to manage the publication of your media package to YouTube, and 
you must configure a YouTube v3 publication account in MediaCentral UX.

The following procedures assume you have created a Google account at 
https://accounts.google.com/.

n The user interface for Google accounts might change without notice. The procedure below outlines 
the general steps to create the elements needed to configure Media Distribute. For more information 
on creating and managing a Google or YouTube application, see your Google developer account 
documentation.

If you use a YouTube profile created before April 2015, you can follow the procedures described in 
“Configuring a YouTube Publication Account” on page 79. For new profiles, you can use the Avid 
Media Distribute Integration application to generate the necessary access token and refresh token. 
MediaCentral UX also supplies the following default parameter values when it creates a new 
YouTube v3 profile so it can use the Avid application: 

• Client Id

• Client Secret

• Scopes

• Redirect URI

n To use the Avid Media Distribute Integration application to generate default values for your YouTube 
v3 account, you must be logged in to the Google account you use for publishing videos from Media 
Distribute.

If you want to create your own YouTube application, you can replace the profile parameter values 
with those copied from your YouTube application. You need to generate the Client ID and Client 
Secret from the OAuth 2.0 credentials in the Credentials Web page in the APIs and auth section of 
your application in the Google Developers Console. You also need to supply the values for the 
Scopes and Redirect URI parameters. For more information, see the Google Developers 
documentation.

To configure MediaCentral UX for your YouTube v3 account:

1. Log on to your Google account at https://accounts.google.com/.

2. If you have never used this account to upload a video, do the following to create a YouTube 
channel:

a. In your browser, navigate to https://www.youtube.com/my_videos.

b. Create a new channel. For information creating a new YouTube channel, see the YouTube 
online help.

3. Sign in to MediaCentral UX as an administrator.

https://www.youtube.com/my_videos
https://accounts.google.com/
https://accounts.google.com/
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4. Select System Settings from the Layout selector. 

The System Settings layout opens.

5. In the Settings pane select Media Distribute > Profiles.

The Settings pane displays the settings in that group.

6. Click the Publication Type menu and select YouTube v3.

7. Click the + (plus) button in the Details section.

A YouTube v3 profile named “New Profile” is created in the Details section, and the following 
parameter fields are automatically filled by default:

- Client ID

- Client Secret

- Scopes

- Redirect URI

8. Specify a Profile Name by typing a descriptive name for your profile.

9. Click the Privacy Settings menu and select one of the following options:

t Public — Everyone can view your published videos.

t Unlisted — Only those with whom you share a URL link can view your published video. 

t Private — Videos cannot be viewed by the public.
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10. Click Get Tokens.

The Avid Media Distribute Integration application opens a Web page asking permission to 
manage your YouTube account. This allows the application to generate the necessary access 
tokens so you can publish videos to your YouTube account.

n If you already received the access and refresh tokens, clicking Get Tokens does not supply you with 
new tokens. You need to click Revoke Tokens, and then click Get Tokens.

11. Click Allow.

The Avid Media Distribute Integration application generates the access tokens and displays them 
on the application Web page.

12. Copy the Access Token value to the parameter field for Access Token in your MediaCentral 
YouTube v3 profile.

13. Copy the Refresh Token value to the parameter field for Refresh Token in your MediaCentral 
YouTube v3 profile.

14. Click Transcoding Profile and select one of the available profiles.

15. Click Verify Profile Settings to validate the profile settings.

If your profile is valid, a message displays: “Profile configurations is valid.” If any settings are 
incorrect, a message displays and indicates which fields are incorrect. All invalid settings names 
change to red. 

16. Click Apply to save the profile. 

The profile displays in the Details section with the new information.

If you are editing a profile, click Revert to return to the original settings. If you want to delete a 
profile, select the profile and click the minus (-) button in the Details section.
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Configuring a Brightcove Account
Before you can publish a package to Brightcove from MediaCentral UX using Media Distribute, you 
must first set up a Brightcove account to which you want to publish, and you must configure the 
Brightcove Media API settings for your account.

The following procedures assume you have created a Brightcove account at 
http://www.brightcove.com/en/.

n You must have a paid Brightcove account to use the Brightcove Video Cloud Media API to publish 
packages from MediaCentral UX to the Brightcove service.

The Media Distribute settings for Brightcove allow you to select some rendition options when you 
publish to your Brightcove account. A rendition is a copy of your video transcoded to a specific bit 
rate and resolution. If your video is supported for transcoding, you can use Media Distribute to create 
multiple renditions as specified in your transcoding profile. If you use a video with the H.264 format, 
you can also retain this format as a rendition when you create multiple renditions.

To set up a Brightcove account for MediaCentral UX multi-platform delivery:

1. Log on to your Brightcove account, and click the Account Settings tab.

The Account Settings Web page opens.

2. In the navigation panel on the left, click API Management.

The API Management Web page opens.

3. To create tokens, do the following:

a. Click the Add a: menu and select Read Token with URL Access, and then click Add.

b. Click the Add a: menu and select Write Token, and then click Add.

The tokens appear in the Token list.

4. Save the following parameter fields from the API Management Web page so you can enter them 
in the appropriate location in the MediaCentral UX settings:

- Read Token with URL Access

- Write Token

http://www.brightcove.com/en/
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To configure MediaCentral UX for your Brightcove account:

1. Sign in to MediaCentral UX as an administrator.

2. Select System Settings from the Layout selector. 

The System Settings layout opens.

3. In the Settings pane select Media Distribute > Profiles.

The Settings pane displays the settings in that group.

4. Click the Publication Type menu and select Brightcove.

5. Click the + (plus) button in the Details section.

A Brightcove profile named “New Profile” is created in the Details section.

6. Specify the required settings, using the parameter fields you copied from your Brightcove API 
Management Web page:

- Profile Name (type a descriptive name for your profile)

- Read Token

- Write Token

7. Click Transcoding Profile and select one of the available profiles.

8. (Optional) If you want to create multiple transcoded versions of your media as specified in your 
transcoding profile, select Create multiple renditions.

9. (Optional) If you want to keep a copy of your video at the source H.264 rendition in addition to 
any other renditions created, select Preserve source rendition. This option is selected by default.

10. Click Verify Profile Settings to validate the profile settings.

If your profile is valid, a message displays: “Profile configurations is valid.” If any settings are 
incorrect, a message displays and indicates which fields are incorrect. All invalid settings names 
change to red. 
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11. Click Apply to save the profile. 

The profile displays in the Details section with the new information.

If you are editing a profile, click Revert to return to the original settings. If you want to delete a 
profile, select the profile and click the minus (-) button in the Details section.

Configuring a Kaltura Account
Before you can publish a package to Kaltura from MediaCentral UX using Media Distribute, you 
must first set up a Kaltura account to which you want to publish, and you must configure the Kaltura 
Media API settings for your account.

The following procedures assume you have created a Kaltura account at http://corp.kaltura.com/.

To set up a Kaltura account for MediaCentral UX multi-platform delivery:

1. Log on to your Kaltura account at http://corp.kaltura.com/, and click the Settings tab.

The Account Settings Web page opens.

2. Click Integration Settings tab.

The Integration Settings Web page opens.

3. Save the following parameter fields from the Integration Settings Web page so you can enter 
them in the appropriate location in the MediaCentral UX settings:

- Partner ID

- Administration Secret

To configure MediaCentral UX for your Kaltura account:

1. Sign in to MediaCentral UX as an administrator.

2. Select System Settings from the Layout selector. 

The System Settings layout opens.

http://corp.kaltura.com/
http://corp.kaltura.com/
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3. In the Settings pane select Media Distribute > Profiles.

The Settings pane displays the settings in that group.

4. Click the Publication Type menu and select Kaltura.

5. Click the + (plus) button in the Details section.

A Kaltura profile named “New Profile” is created in the Details section.

6. Specify the required settings, using the parameter fields you copied from your Kaltura API 
Management Web page:

- Profile Name (type a descriptive name for your profile)

- Partner ID

- User ID (your login credential)

- Admin Secret

7. Click Transcoding Profile and select one of the available profiles.

8. Click Verify Profile Settings to validate the profile settings.

If your profile is valid, a message displays: “Profile configurations is valid.” If any settings are 
incorrect, a message displays and indicates which fields are incorrect. All invalid settings names 
change to red. 

9. Click Apply to save the profile. 

The profile displays in the Details section with the new information.

If you are editing a profile, click Revert to return to the original settings. If you want to delete a 
profile, select the profile and click the minus (-) button in the Details section.
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Configuring an Ooyala Account
Before you can publish a package to Ooyala from MediaCentral UX using Media Distribute, you 
must first set up an Ooyala account to which you want to publish, and you must check the Backlot 
API settings for your account.

The following procedures assume you have created an Ooyala account at 
https://backlot.ooyala.com/backlot/web.

To set up an Ooyala account for MediaCentral UX multi-platform delivery:

1. Log on to your Ooyala Backlot account.

The Ooyala Backlot Web page opens.

2. Click the Account tab, and then click the Developers tab.

The Backlot API Web page opens.

3. Save the following parameter fields from the Backlot API Web page so you can enter them in the 
appropriate location in the MediaCentral UX settings:

- API Key

- API Secret

To configure MediaCentral UX for your Ooyala account:

1. Sign in to MediaCentral UX as an administrator.

2. Select System Settings from the Layout selector. 

The System Settings layout opens.

https://backlot.ooyala.com/backlot/web
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3. In the Settings pane select Media Distribute > Profiles.

The Settings pane displays the settings in that group.

4. Click the Publication Type menu and select Ooyala.

5. Click the + (plus) button in the Details section.

An Ooyala profile named “New Profile” is created in the Details section.

6. Specify the required settings, using the parameter fields you copied from your Ooyala Backlot 
API Web page:

- Profile Name (type a descriptive name for your profile)

- API Key

- API Secret

7. Click Transcoding Profile and select one of the available profiles.

8. Click Verify Profile Settings to validate the profile settings.

If your profile is valid, a message displays: “Profile configurations is valid.” If any settings are 
incorrect, a message displays and indicates which fields are incorrect. All invalid settings names 
change to red. 

9. Click Apply to save the profile. 

The profile displays in the Details section with the new information.

If you are editing a profile, click Revert to return to the original settings. If you want to delete a 
profile, select the profile and click the minus (-) button in the Details section.

Configuring a Flickr Account
Before you can publish a package to Flickr from MediaCentral UX using Media Distribute, you must 
first set up an Flickr account to which you want to publish, and you must check the Flickr App 
Garden settings for your account.
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The following procedures assume you have created an Flickr account at https://www.flickr.com, and 
that you have created your Flickr app. For information on creating apps for Flickr, see the Flickr 
documentation at https://www.flickr.com/services/api/.

To set up an Flickr account for MediaCentral UX multi-platform delivery:

1. Log in to your Flickr account.

2. Select Explore > App Garden.

3. In the Your Apps section, click Apps By You.

The App Garden page displays your apps.

4. Click the name of your app and save the following parameter fields so you can enter them in the 
appropriate location in the MediaCentral UX settings:

- API Key

- API Secret

To configure MediaCentral UX for your Flickr account:

1. Sign in to MediaCentral UX as an administrator.

2. Select System Settings from the Layout selector. 

The System Settings layout opens.

3. In the Settings pane select Media Distribute > Profiles.

The Settings pane displays the settings in that group.

4. Click the Publication Type menu and select Flickr.

5. Click the + (plus) button in the Details section.

An Flickr profile named “New Profile” is created in the Details section.

https://www.flickr.com/services/api/
https://www.flickr.com
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6. Specify the required settings, using the parameter fields you copied from your Flickr app in the 
App Garden.

- Profile Name (type a descriptive name for your profile)

- API Key (from your app settings in the Flickr App Garden)

- API Secret (from your app settings in the Flickr App Garden)

7. To get your Access Token and Access Secret, do the following:

a. Click Get Access Token.

The Get Access Token dialog box opens.

b. Click Request Token.

The Get Access Token dialog box updates and provides a URL link for the access token.
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c. Click the URL link in the Get Access Token dialog box.

The authorization Web page for your Flickr app opens.

d. Click OK, I’ll Authorize It.

The Flickr authorization Web page displays your authorization code.

e. Type your authorization code in the Verifier text box in the Get Access Token dialog box, 
and then click Exchange token.

The Get Access Token displays your Flickr app account data.

f. Click Save Token and Close.

The Get Access Token dialog box closes, and the following fields are automatically filled in 
the Flickr Profile:

- Access Token

- Access Secret

8. Click Transcoding Profile and select one of the available profiles.



Configuring an Atex Polopoly Web CMS Account

96

9. Click Verify Profile Settings to validate the profile settings.

If your profile is valid, a message displays: “Profile configurations is valid.” If any settings are 
incorrect, a message displays and indicates which fields are incorrect. All invalid settings names 
change to red. 

10. Click Apply to save the profile. 

The profile displays in the Details section with the new information.

If you are editing a profile, click Revert to return to the original settings. If you want to delete a 
profile, select the profile and click the minus (-) button in the Details section.

Configuring an Atex Polopoly Web CMS Account
Before you can publish a package to Polopoly from MediaCentral UX using Media Distribute, you 
must first have a Polopoly account with Atex and set up a Polopoly environment.

You can create multiple Polopoly profiles in the System Settings layout, but you can only configure 
one Web CMS account at a time — for example, you can configure MediaCentral UX either for 
Polopoly or for WorldNow, but not for both.

The following procedures assume you have already created the necessary Polopoly environment. See 
your Polopoly documentation for more information.

To configure your Polopoly server for MediaCentral UX multi-platform delivery:

1. Log on to your Polopoly server using one of the following set of credentials.

- Log in as root with the your root password.

- Log in as centos with your centos password.

SSH is turned off by default.

2. To make the Polopoly user interface accessible through the server firewall, type to following to 
open a port: iptables -I INPUT 1 -i eth0 -p tcp --dport 8080 -j ACCEPT

3. If the Polopoly services are not running, do the following:

a. Type su and press Return.

b. At the prompt, type the password you used to log in to the server.

c. Start the MySQL database by typing the following: cd 
/usr/local/mysql/support-files./mysql.server start

d. Navigate to the Jboss directory by typing cd /opt/jboss and then start Jboss by typing the 
following: bin/run.sh -b 0.0.0.0 &

e. Navigate to the Tomcat directory by typing cd /opt/tomcat and then start Tomcat by 
typing the following: bin/startup.sh

To configure MediaCentral UX for your Polopoly account:

1. Sign in to MediaCentral UX as an administrator.

2. Select System Settings from the Layout selector. 

The System Settings layout opens.
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3. In the Settings pane select Media Distribute > Profiles.

The Settings pane displays the settings in that group.

4. Click the Publication Type menu and select Polopoly.

5. Click the + (plus) button in the Details section.

A Polopoly profile named “New Profile” is created in the Details section.

6. Specify the required settings for the following parameter fields:

- Profile Name (type a descriptive name for your profile)

- Server (the name of your Polopoly host — for example, http://localhost :80080)

- User Name (your Polopoly login name)

- Password (your Polopoly login password)

- Service Address (the address of the Polopoly REST service — for example, polopoly)

- External ID (from your Polypoly account settings)

7. Click OVP Profile and select one of the available profiles. OVP profiles are created when you 
configure your online video provider settings — for example, when you set up MediaCentral UX 
for your Vimeo or YouTube account. For more information, see “Configuring a Vimeo 
Publication Account” on page 73 or “Configuring a YouTube Publication Account” on page 79.

8. Click Verify Profile Settings to validate the profile settings.

If your profile is valid, a message displays: “Profile configurations is valid.” If any settings are 
incorrect, a message displays and indicates which fields are incorrect. All invalid settings names 
change to red. 
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9. Click Apply to save the profile. 

The profile displays in the Details section with the new information.

If you are editing a profile, click Revert to return to the original settings. If you want to delete a 
profile, select the profile and click the minus (-) button in the Details section.

Configuring a WorldNow Web CMS Profile

Before you can publish a package to the WorldNow platform from MediaCentral UX using Media 
Distribute, you must first have a WorldNow account and set up a WorldNow environment.

The following procedures assume you have already created the necessary WorldNow environment. 
Your WorldNow account provides you with the following information needed to complete your 
MediaCentral UX configuration:

• Account user name

• Account password

• Affiliate number

• Producer host

• Ingest FTP host

• Ingest FTP path

• Ingest FTP user name

• Ingest FTP password

The following notes apply to using WorldNow with MediaCentral UX:

• Once you have configured MediaCentral UX for your WorldNow CMS, the fields available to 
you in the Web Story pane change to reflect the options and metadata provided by WorldNow.

• You can create multiple WorldNow profiles in the System Settings layout, but you can only 
configure one Web CMS account at a time — for example, you can configure MediaCentral UX 
either for WorldNow or for Atex Polopoly, but not for both.

• You can set the default values for some options used when you publish to a WorldNow account 
so you do not have to set them in the Web Story pane each time you create a story. Some values 
display as automatically selected options and some control the size and placement of graphics 
when you attach images to your story. These options correspond to those available in your 
WorldNow CMS.

See your WorldNow documentation for more information, or see the WorldNow Web site at 
www.worldnow.com. 

n A limitation in the current version of Media Distribute might cause an SSLHandshakeException 
error to occur and prevent posting video to WorldNow. This is caused by a problem where the client 
and server cannot negotiate the desired level of security. To work around this problem, you can 
disable SSL validation for HTTPS connections.

http://www.worldnow.com/
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To configure MediaCentral UX for your WorldNow account:

1. Sign in to MediaCentral UX as an administrator.

2. Select System Settings from the Layout selector. 

The System Settings layout opens.

3. In the Settings pane select Media Distribute > Profiles.

The Settings pane displays the settings in that group.

4. Click the Publication Type menu and select WorldNow.

5. Click the + (plus) button in the Details section.

A WorldNow profile named “New Profile” is created in the Details section.

6. Specify the required settings for the following parameter fields:

- Profile Name (type a descriptive name for your profile)

- Username (your WorldNow login name)

- Password (your WorldNow login password)

- Affiliate Number (from your WorldNow account information)

- Producer Host (from your WorldNow account information)

- FTP Ingest Hostname (from your WorldNow account information)

- FTP Path (optional) — if your ingest FTP location is configured to use a directory other than 
the root folder, you can specify a different FTP directory or subdirectory. If the transcode 
in/out has not changed, you can leave this setting blank.
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- FTP Username (from your WorldNow account information)

- FTP Password (from your WorldNow account information)

7. Click Transcoding Profile and select one of the available profiles.

8. Click Verify Profile Settings to validate the profile settings.

If your profile is valid, a message displays: “Profile configurations is valid.” If any settings are 
incorrect, a message displays and indicates which fields are incorrect. All invalid settings names 
change to red. 

9. Click Apply to save the profile. 

The profile displays in the Details section with the new information.

If you are editing a profile, click Revert to return to the original settings. If you want to delete a 
profile, select the profile and click the minus (-) button in the Details section.

To set default values in MediaCentral UX for your WorldNow account:

1. Sign in to MediaCentral UX as an administrator.

2. Select System Settings from the Layout selector. 

The System Settings layout opens.

3. In the Settings pane select Media Distribute > WorldNow.

The Settings pane displays the WorldNow settings.
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4. Select the WorldNow options that you want to use as default values in the Web Story pane.

- Story options can be set to use your Story Headline in some additional areas for your Web 
story. You can also select a default classification for your story from the Content 
Classification menu.

- Use Headline as Abridged Title

- Use Headline as Browser Title

- Use Headline as Page URL

- Content Classification

- Graphics options control the default size (in pixels) and alignment of images in your Web 
story.

- Story Body Image Size

- Summary Image Size

- Summary Image Alignment

- Abstract Image Size

- Abstract Image Alignment

- Video options can be set to use your Headline in some additional areas for your Web story. 
You can also enable closed captions for your story and select a default classification from the 
Content Classification menu.

- Use Headline as Abridged Title

- Use Headline as Browser Title

- Use Headline as Page URL

- Enable Closed Captioning

- Content Classification

5. Click Apply to save the settings. 

The WorldNow options display in the Details section with the new information.

If you are editing your WorldNow settings, click Revert to return to the original settings. 

To disable SSL validation:

1. In a terminal window on the master cluster node, type the following to stop ServiceMix:

service avid-mpd stop

2. Navigate to the directory containing the Media Distribute database configuration file:

cd /etc/apache-servicemix

3. Using the Linux text editor, vi, open the avid-mpd-wrapper.conf file for editing:

vi avid-mpd-wrapper.conf

4. Locate the following line in the JVM Parameters section, and then edit the SSL validation to 
true:

# wrapper.java.additional.<NUMBER>=-Dmpd.ssl.trust.all=true

5. Press the Escape key to return to command mode, then type :wq and press Return to write and 
quit the text editor.
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6. To restart the Media Distribute service, type the following command:

service avid-mpd restart

Configuring thePlatform Profile

Before you can publish a package to thePlatform® video CMS from MediaCentral UX using Media 
Distribute, you must first have an account for thePlatform and set up an administrative role.

The following procedures assume you have already created the necessary thePlatform environment. 
Your thePlatform account provides you with the following information needed to complete your 
MediaCentral UX configuration:

• Account user name

• Account password

Once you have configured MediaCentral UX for your thePlatform account, you can use the fields 
available to you in a separate thePlatform pane that reflect the options and metadata provided by 
thePlatform. You can also specify upload servers for your media package if these servers are part of 
your thePlatform configuration. Media Distribute uploads media directly to these servers when you 
publish your media package. If you configure an FTP ingest server instead, Media Distribute uploads 
your media to this server. If you do not configure either upload servers or an FTP server, Media 
Distribute automatically selects an appropriate upload server.

See your thePlatform documentation for more information, or see thePlatform Technical Resource 
Center at help.theplatform.com. 

To configure MediaCentral UX for your thePlatform account:

1. Sign in to MediaCentral UX as an administrator.

2. Select System Settings from the Layout selector. 

The System Settings layout opens.

http://help.theplatform.com
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3. In the Settings pane select Media Distribute > Profiles.

The Settings pane displays the settings in that group.

4. Click the Publication Type menu and select thePlatform.

5. Click the + (plus) button in the Details section.

A new thePlatform profile named “New Profile” is created in the Details section.

6. Specify the required settings for the following parameter fields:

- Profile Name (type a descriptive name for your profile)

- Username (your thePlatform login name)

- Password (your thePlatform login password)

7. Click Transcoding Profile and select one of the available profiles.

8. (Optional) If your thePlatform configuration specifies upload servers, do the following: 

a. Click Get Upload Servers by Username and Password.

The upload servers for your thePlatform account are retrieved.

b. Click the Upload Server options used in your thePlatform profile and select the appropriate 
server for the following options:

- Metadata Upload Server

- Video Upload Server
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- Image Upload Server

- CC [Closed Captioning] Upload Server

n If you use an FTP ingest server, do not specify upload servers.

9. If you use an FTP ingest server for publishing to thePlatform, type the hostname of the FTP 
ingest server and the path to the FTP server.

10. If applicable, type the FTP user name and the FTP password.

11. Click Verify Profile Settings to validate the profile settings.

If your profile is valid, a message displays: “Profile configurations is valid.” If any settings are 
incorrect, a message displays and indicates which fields are incorrect. All invalid settings names 
change to red. 

12. Click Apply to save the profile. 

The profile displays in the Details section with the new information.

If you are editing a profile, click Revert to return to the original settings. If you want to delete a 
profile, select the profile and click the minus (-) button in the Details section.

Configuring a WordPress CMS Profile

Before you can publish a package to the WordPress® platform from MediaCentral UX using Media 
Distribute, you must first set up your WordPress CMS and have a WordPress administrative account.

The following procedures assume you have already created the necessary WordPress CMS 
environment. Your WordPress installation provides you with the following information needed to 
complete your MediaCentral UX configuration:

• Blog ID — Media Distribute uses a default blog ID of “1.” If your WordPress configuration uses 
multiple blog sites, you might need to assign a different blog ID.

• Administrator account user name

• Administrator account password

• Your WordPress host’s API URL — The default XML-RPC API is 
“http://[your_WordPress_IP]/xmlrpc.php. You can disable or reconfigure this URL if needed.

WordPress allows you to configure your site in many ways and the default Media Distribute settings 
might not be appropriate for your corporate needs. See your WordPress administrator or the 
WordPress documentation for more information on customizing your account details, or see the 
WordPress Web site at wordpress.org. 

To configure MediaCentral UX for your WordPress account:

1. Sign in to MediaCentral UX as an administrator.

2. Select System Settings from the Layout selector. 

The System Settings layout opens.

https://wordpress.org
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3. In the Settings pane select Media Distribute > Profiles.

The Settings pane displays the settings in that group.

4. Click the Publication Type menu and select WordPress.

5. Click the + (plus) button in the Details section.

A WordPress profile named “New Profile” is created in the Details section.

6. Specify the required settings for the following parameter fields:

- Profile Name (type a descriptive name for your profile)

- Blog ID (from your WordPress configuration information — the default blog ID is “1”)

- Username (your WordPress administrator login name)

- Password (your WordPress administrator login password)

- Host’s API URL (from your WordPress configuration information — usually this is your 
WordPress URL followed by /xmlrpc.php)

7. Click Transcoding Profile and select one of the available profiles.

8. Click Verify Profile Settings to validate the profile settings.

If your profile is valid, a message displays: “Profile configurations is valid.” If any settings are 
incorrect, a message displays and indicates which fields are incorrect. All invalid settings names 
change to red. 

9. Click Apply to save the profile. 

The profile displays in the Details section with the new information.

If you are editing a profile, click Revert to return to the original settings. If you want to delete a 
profile, select the profile and click the minus (-) button in the Details section.
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Configuring an Amazon S3 Profile

Before you can publish video and graphics assets to your Amazon Simple Storage Service (Amazon 
S3) account from MediaCentral UX using Media Distribute, you must first have an Amazon Web 
Services (AWS) account.

The following procedures assume you have already created the necessary AWS account and obtained 
the necessary access keys. Your AWS account provides you with the following information needed to 
complete your MediaCentral UX configuration:

• Access key (created using the AWS Management Console)

• Secret access key (created using the AWS Management Console — Avid recommends that you 
make a copy of this key when you create your access key, since it is not available in your AWS 
account after you create your key)

• Endpoint (a regional URL that acts as the entry point for your Web service and created using 
AWS)

• Bucket name (a location that holds the content for your Amazon S3 account)

For more information on AWS configuration and customizations, see the AWS documentation at 
https://aws.amazon.com/documentation/s3/. 

To configure MediaCentral UX for your Amazon S3 account:

1. Sign in to MediaCentral UX as an administrator.

2. Select System Settings from the Layout selector. 

The System Settings layout opens.

3. In the Settings pane select Media Distribute > Profiles.

The Settings pane displays the settings in that group.

4. Click the Publication Type menu and select Amazon S3.

https://aws.amazon.com/documentation/s3/
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5. Click the + (plus) button in the Details section.

An Amazon S3 profile named “New Profile” is created in the Details section.

6. Specify the required settings for the following parameter fields:

- Profile Name (type a descriptive name for your profile)

- Access Key (from your AWS account information, stored in the security credentials section 
of your account)

- Secret Access Key (from your AWS account information; the secret access key is displayed 
only when you create your access key, so you should make a copy of it before you finish the 
access key creation procedure)

- Endpoint (a regional endpoint created when you configure your AWS account — for 
example, to use the Amazon S3 endpoints, you can specify “s3-external-1.amazonaws.com” 
for the eastern United States)

- Bucket Name (the name you create for your bucket; see the AWS documentation for valid 
and invalid bucket names)

7. Click Transcoding Profile and select one of the available Interplay MAM profiles. If you select a 
different transcoding profile, you can only use Interplay Production assets.

8. Click Apply to save the profile. 

The profile displays in the Details section with the new information.

If you are editing a profile, click Revert to return to the original settings. If you want to delete a 
profile, select the profile and click the minus (-) button in the Details section.

Configuring a Generic CMS Profile

The Generic CMS profile allows you to integrate a third-party, unsupported CMS with Media 
Distribute. Depending on how you configure your Generic CMS profile, you can deliver media files 
to your FTP location using one of two methods: 

• If you select Archive in the settings, the profile creates a compressed (ZIP) file containing an 
XML file with profile information and metadata, as well as an image file (PNG) and a video file 
(MP4) if images and video are included in the media package. Media Distribute then delivers the 
file to your FTP location. 

n You must select a transcoding profile in order to create the MP4 video file. If you want to deliver your 
video as an MXF file, select the NoOpTranscoder profile.

• If you want to deliver images and video to separate FTP locations, you can specify settings to 
send images and video to different servers or to different folders on your FTP server. An XML 
file also is delivered to the principal FTP host indicated in the profile settings. If you do not 
specify separate image and video FTP locations, all files are delivered to the principal FTP 
location.

n If you load an image from the Media pane, the profile retrieves image and video metadata and stores 
it with the image. You can view the metadata in the Metadata pane. If you load an image from a local 
disk, only basic metadata is included with the information sent to your FTP site.

You need to develop a proxy target that can receive the files from the FTP location listed in the 
profile and then deliver them to a CMS using proper API.
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The Generic CMS profile should be used only by Avid personnel. See your Avid professional 
services representative for more information.

To configure MediaCentral UX for a Generic CMS profile:

1. Sign in to MediaCentral UX as an administrator.

2. Select System Settings from the Layout selector. 

The System Settings layout opens.

3. In the Settings pane select Media Distribute > Profiles.

The Settings pane displays the settings in that group.

4. Click the Publication Type menu and select GenericCMS.

5. Click the + (plus) button in the Details section.

A Generic CMS profile named “New Profile” is created in the Details section.
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6. Specify the required settings, using the configuration on your CMS and FTP configuration:

- Profile Name (type a descriptive name for your profile)

- Provider ID (The provider ID identifies your CMS and is included in the XML file created 
by the profile. If your CMS does not require a specific provider ID, you can type any name 
in this field.)

- FTP Hostname (your CMS server hostname)

- FTP Path (for incoming files, from your video host transcoding configuration)

- FTP Username (from your video host transcoding configuration)

- FTP Password (from your video host transcoding configuration)

7. (Optional) Click Transcoding Profile and select one of the available profiles. Transcoding 
profiles are created when you configure your transcoding host — for example, when you set up 
MediaCentral UX for the Telestream Vantage video transcoder. For more information, see 
“Configuring the Transcode Route” on page 31. You can also select the NoOpTranscoder profile, 
which delivers the video as an MXF file instead of converting it to MP4 format.

8. (Optional) Click OVP Profile and select one of the available profiles. OVP profiles are created 
when you configure your online video provider settings — for example, when you set up 
MediaCentral UX for your Vimeo or YouTube account. For more information, see “Configuring 
a Vimeo Publication Account” on page 73 or “Configuring a YouTube Publication Account” on 
page 79.

9. Do one of the following:

t If you want to send image and video metadata to the FTP host in a single compressed ZIP 
file, select Archive.
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t If you want to deliver the image and video, along with the image and video metadata, to 
separate FTP sites, specify the following optional settings:

- Image FTP Host (the FTP server hostname for delivery of image files and metadata) 

- Image FTP Path (the path on your FTP server that you want to use for delivery of image files 
and metadata) 

- Image FTP Login (the account name used to log in to your FTP server) 

- Image FTP Password (the password for your FTP server account) 

- Video FTP Host (the FTP server hostname for delivery of video files and metadata)

- Video FTP Path (the path on your FTP server that you want to use for delivery of video files 
and metadata)

- Video FTP Login (the account name used to log in to your FTP server) 

- Video FTP Password (the password for your FTP server account)



Configuring a Generic CMS Extended Profile

111

10. Click Verify Profile Settings to validate the profile settings.

If your profile is valid, a message displays: “Profile configurations is valid.” If any settings are 
incorrect, a message displays and indicates which fields are incorrect. All invalid settings names 
change to red. 

11. Click Apply to save the profile.

The profile displays in the Details section with the new information.

If you are editing a profile, click Revert to return to the original settings. If you want to delete a 
profile, select the profile and click the minus (-) button in the Details section.

Configuring a Generic CMS Extended Profile
The Generic CMS Extended profile allows you to integrate a third-party, unsupported CMS with 
Media Distribute, and it allows you to use the Generic CMS Extended pane to publish your media 
packages. Depending on how you configure your Generic CMS Extended profile, you can deliver 
media files to your FTP location using one of two methods: 

• If you select Archive in the settings, the profile creates a compressed (ZIP) file containing an 
XML file with profile information and metadata, as well as an image file (PNG) and a video file 
(MP4) if images and video are included in the media package. Media Distribute then delivers the 
file to your FTP location. 

n You must select a transcoding profile in order to create the MP4 video file. If you want to deliver your 
video as an MXF file, select the NoOpTranscoder profile.

• If you want to deliver images and video to separate FTP locations, you can specify settings to 
send images and video to different servers or to different folders on your FTP server. An XML 
file also is delivered to the principal FTP host indicated in the profile settings. If you do not 
specify separate image and video FTP locations, all files are delivered to the principal FTP 
location.

If you load an image or video from the Media pane, the profile retrieves image and video metadata 
and stores it with the story. Some of the Interplay Production metadata fields are filled automatically 
and display in the story form. You can view the full set of metadata in the Metadata pane, and you 
can use the Reload Metadata button in the Generic CMS Extended pane to re-load the metadata to the 
fields. If you load an image from a local disk, only basic metadata is included with the information 
sent to your FTP site.

You also have the option of customizing the categories that display in the Generic XML Extended 
pane by including an XSL file that can implement transforms on existing metadata. For more 
information, see “Sample XSL for the Generic CMS Extended Profile” on page 148.

You need to develop a proxy target that can receive the files from the FTP location listed in the 
profile and then deliver them to a CMS using the proper API.

To configure MediaCentral UX for a Generic CMS Extended profile:

1. Sign in to MediaCentral UX as an administrator.

2. Select System Settings from the Layout selector. 

The System Settings layout opens.
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3. In the Settings pane select Media Distribute > Profiles.

The Settings pane displays the settings in that group.

4. Click the Publication Type menu and select Generic CMS Extended.

5. Click the + (plus) button in the Details section.

A Generic CMS Extended profile named “New Profile” is created in the Details section.

6. Specify the required settings, using the configuration on your CMS and FTP configuration:

- Profile Name (type a descriptive name for your profile)

- Auto approve (select this option if you want the publishing process to start as soon as the 
package is saved; do not select the option if you want to the package to be approved first by 
an authorized user.)

- Media Groups (You can use this field for a user-defined property by typing a text string with 
each value separated by a semicolon. In the story form, the Media Groups menu contains a 
list with all of the properties. You can select a value from the menu in the story form and the 
selected entry is exported with the XML file.)
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- FTP Hostname (your FTP server hostname)

- FTP Path (for incoming files, from your video host transcoding configuration)

- FTP Username (from your video host transcoding configuration)

- FTP Password (from your video host transcoding configuration)

7. Click Transcoding Profile and select one of the available profiles. Transcoding profiles are 
created when you configure your transcoding host — for example, when you set up 
MediaCentral UX for the Telestream Vantage video transcoder. For more information, see 
“Configuring the Transcode Route” on page 31. You can also select the NoOpTranscoder profile, 
which delivers the video as an MXF file instead of converting it to MP4 format.

8. (Optional) Click OVP Profile and select one of the available profiles. OVP profiles are created 
when you configure your online video provider settings — for example, when you set up 
MediaCentral UX for your Vimeo or YouTube account. For more information, see “Configuring 
a Vimeo Publication Account” on page 73 or “Configuring a YouTube Publication Account” on 
page 79.

9. Do one of the following:

t If you want to send image and video metadata to the FTP host in a single compressed ZIP 
file, select Archive.
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t If you want to deliver the image and video, along with the image and video metadata, to 
separate FTP sites, specify the following optional settings:

- Image FTP Host (the FTP server hostname for delivery of image files and metadata) 

- Image FTP Path (the path on your FTP server that you want to use for delivery of image files 
and metadata) 

- Image FTP Login (the account name used to log in to your FTP server) 

- Image FTP Password (the password for your FTP server account) 

- Video FTP Host (the FTP server hostname for delivery of video files and metadata)

- Video FTP Path (the path on your FTP server that you want to use for delivery of video files 
and metadata)

- Video FTP Login (the account name used to log in to your FTP server) 

- Video FTP Password (the password for your FTP server account)
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10. Metadata XSL (Type or copy and paste the content of a metadata XSL file into the text box to 
allow for metadata transformation and mapping of the attributes. The metadata is exported in the 
XML file, according to the naming conventions for your CMS.)

11. Click Apply to save the profile.

The profile displays in the Details section with the new information.

If you are editing a profile, click Revert to return to the original settings. If you want to delete a 
profile, select the profile and click the minus (-) button in the Details section.

Configuring a NoOpTranscoder Profile

The NoOpTranscoder profile allows you to deliver video packages without first converting the video 
to an MP4 file. This allows you to bypass the transcoding process and to upload MXF files directly to 
an online video provider that supports MXF video — for example, YouTube. Using MXF video 
instead of MP4 video can improve the video image quality.

To configure MediaCentral UX for publishing MXF video:

1. Sign in to MediaCentral UX as an administrator.

2. Select System Settings from the Layout selector. 

The System Settings layout opens.

3. In the Settings pane select Media Distribute > Profiles.

The Settings pane displays the settings in that group.

4. Click the Publication Type menu and select NoOpTranscoder.

5. Click the + (plus) button in the Details section.

A NoOpTranscoder profile named “New Profile” is created in the Details section.

6. Specify a Profile Name (a descriptive name for your profile).

7. Click Apply to save the profile.

The profile displays in the Details section with the new information.

If you are editing a profile, click Revert to return to the original settings. If you want to delete a 
profile, select the profile and click the minus (-) button in the Details section.
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Configuring a Generic OVP Profile

The Generic OVP profile allows you to post to a third-party, unsupported online video provider 
(OVP) using Media Distribute. If you select an OVP profile and a transcode profile, Media Distribute 
transcodes your media to the MP4 format and publishes the media to the specified OVP site. The 
MP4 media file is contained in a compressed (ZIP) file which also contains an XML file with a link 
to the uploaded video. You can select both options to send your media to both an FTP and an OVP 
location.

The Generic OVP profile should be used only by Avid personnel. See your Avid professional services 
representative for more information.

To configure MediaCentral UX for a Generic OVP profile:

1. Sign in to MediaCentral UX as an administrator.

2. Select System Settings from the Layout selector. 

The System Settings layout opens.

3. In the Settings pane select Media Distribute > Profiles.

The Settings pane displays the settings in that group.

4. Click the Publication Type menu and select GenericOVP.

5. Click the + (plus) button in the Details section.

A Generic OVP profile named “New Profile” is created in the Details section.
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6. Specify the required settings, using the configuration on your FTP configuration:

- Profile Name (type a descriptive name for your profile)

- FTP Hostname (your FTP server hostname)

- FTP Path (for incoming files, from your video host transcoding configuration)

- FTP Username (from your video host transcoding configuration)

- FTP Password (from your video host transcoding configuration)

7. Click Transcoding Profile and select one of the available profiles.

8. Click Verify Profile Settings to validate the profile settings.

If your profile is valid, a message displays: “Profile configurations is valid.” If any settings are 
incorrect, a message displays and indicates which fields are incorrect. All invalid settings names 
change to red. 

9. Click Apply to save the profile.

The profile displays in the Details section with the new information.

If you are editing a profile, click Revert to return to the original settings. If you want to delete a 
profile, select the profile and click the minus (-) button in the Details section.



4 Configuring User Profiles for 
Media | Distribute

Once your MediaCentral UX administrator had configured your system profiles, you can set up your 
user profiles to include your personal accounts for services such as Twitter and Facebook. User roles 
allow you to publish your packages automatically and without the requirement of review and 
approval.

User profiles are visible only to the user logged in to MediaCentral UX. You cannot see other users’ 
profiles.

For examples of creating user profiles, see the following topics:

• “Configuring a User Profile for an Amazon S3 Account” on page 118

• “Configuring a User Profile for an E-Mail Account” on page 120

• “Configuring a User Profile for a Personal Facebook Account” on page 121

• “Configuring a User Profile for a Personal Facebook Page Account” on page 123

• “Configuring a User Profile for a Personal Flickr Account” on page 125

• “Configuring a User Profile for a Personal Twitter Account” on page 129

• “Configuring a User Profile for a Personal Vimeo V3 Account” on page 130

• “Configuring a User Profile for a Personal YouTube v3 Account” on page 132

Configuring a User Profile for an Amazon S3 Account
Before you can publish video and graphics assets to your Amazon Simple Storage Service (Amazon 
S3) account from MediaCentral UX using Media Distribute, you must first have an Amazon Web 
Services (AWS) account.

The following procedures assume you have already created the necessary AWS account and obtained 
the necessary access keys. Your AWS account provides you with the following information needed to 
complete your MediaCentral UX configuration:

• Access key (created using the AWS Management Console)

• Secret access key (created using the AWS Management Console — Avid recommends that you 
make a copy of this key when you create your access key, since it is not available in your AWS 
account after you create your key)

• Endpoint (a regional URL that acts as the entry point for your Web service and created using 
AWS)

• Bucket name (a location that holds the content for your Amazon S3 account)

For more information on AWS configuration and customizations, see the AWS documentation at 
https://aws.amazon.com/documentation/s3/. 

https://aws.amazon.com/documentation/s3/
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To configure MediaCentral UX for your Amazon S3 account:

1. Sign in to MediaCentral UX.

2. Select Home > User Settings. 

The User Settings dialog box opens.

3. In the Name pane, select Media Distribute.

4. Click the Publication Type menu and select Amazon S3.

5. Click the + (plus) button in the Details section.

An Amazon S3 profile named “New Profile” is created in the Details section.

6. Specify the required settings for the following parameter fields:

- Profile Name (type a descriptive name for your profile)

- Access Key (from your AWS account information, stored in the security credentials section 
of your account)

- Secret Access Key (from your AWS account information; the secret access key is displayed 
only when you create your access key, so you should make a copy of it before you finish the 
access key creation procedure)

- Endpoint (a regional endpoint created when you configure your AWS account — for 
example, to use the Amazon S3 endpoints, you can specify “s3-external-1.amazonaws.com” 
for the eastern United States)

- Bucket Name (the name you create for your bucket; see the AWS documentation for valid 
and invalid bucket names)

7. Click Transcoding Profile and select one of the available Interplay MAM profiles. If you select a 
different transcoding profile, you can only use Interplay Production assets.
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8. Click Apply to save the profile. 

The profile displays in the Details section with the new information.

If you are editing a profile, click Revert to return to the original settings. If you want to delete a 
profile, select the profile and click the minus (-) button in the Details section.

Configuring a User Profile for an E-Mail Account
If you use the Distribution pane to publish media packages, you can configure an e-mail profile to 
send e-mail notifications to one or more users when a package is published. The e-mail profile uses 
the e-mail information configured for MediaCentral UX in the Messages & Sharing panel of the 
System Settings to send the e-mail.

For information on using the Distribution pane, see “Publishing MediaCentral Assets with the 
Distribution Pane” in the Media | Distribute User’s Guide. For information about configuring e-mail 
settings in MediaCentral UX, see “Configuring E-Mail Forwarding” in the Avid MediaCentral | UX 
Administration Guide. 

To configure e-mail notifications:

1. Sign in to MediaCentral UX.

2. Select Home > User Settings. 

The User Settings dialog box opens.

3. In the Name pane, select Media Distribute.

4. Click the Publication Type menu and select E-mail.

5. Click the + (plus) button in the Details section.

An E-mail profile named “New Profile” is created in the Details section.
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6. Specify the required settings:

- Profile Name: Type a descriptive name for your profile)

- Recipients: Type the e-mail address of any user you want to receive notifications. Multiple 
e-mail addresses must be separated by a semicolon (;).

7. Select Send If Publication Fails if you want to receive e-mail notifications when publication fails 
to complete.

8. Click Verify Profile Settings to validate the profile settings.

If your profile is valid, a message displays: “Profile configurations is valid.” If any settings are 
incorrect, a message displays and indicates which fields are incorrect. All invalid settings names 
change to red. 

9. Click Apply to save the profile.

The profile displays in the Details section with the new information.

If you are editing a profile, click Revert to return to the original settings. If you want to delete a 
profile, select the profile and click the minus (-) button in the Details section.

Configuring a User Profile for a Personal Facebook 
Account

The following procedures assume you have created a Facebook account at 
https://www.facebook.com. User roles allow you to publish your packages automatically and without 
the requirement of review and approval.

https://www.facebook.com
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To set up a user profile for Facebook:

1. Sign in to MediaCentral UX.

2. Select Home > User Settings. 

The User Settings dialog box opens.

3. In the Name pane, select Media Distribute.

4. Click the Publication Type menu and select Facebook.

5. Click the + (plus) button in the Details section.

A Facebook profile named “New Profile” is created in the Details section.

6. Specify the required settings, using the parameter fields from your Facebook Apps Web page or 
from your Facebook profile in the MediaCentral UX System Settings layout (see “Configuring a 
Facebook Publication Account” on page 63).

- Profile Name (type a descriptive name for your profile)

- FB Profile ID

- Application ID

- Application Secret

- Application Secret

- Access Token

- (Optional) Album ID

n You can specify the name of a Facebook album if you want to publish images directly to an album that 
you have created for your Facebook account.
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7. (Optional) Click Get Expiration Date.

Media Distribute checks the expiration date of your access token and updates the entry in the 
Expiration Date field. This shows you how much time is left on your Facebook access token.

8. (Optional) Click Get Long-Term Token.

Media Distribute converts your access token, which often remains valid for a couple of hours, to 
a long-lived token. For more information on short-lived and long-lived tokens and their 
expiration periods, see your Facebook developer documentation.

9. Click Verify Profile Settings to validate the profile settings.

If your profile is valid, a message displays: “Profile configurations is valid.” If any settings are 
incorrect, a message displays and indicates which fields are incorrect. All invalid settings names 
change to red. 

10. Click Apply to save the profile. 

The profile displays in the Details section with the new information.

If you are editing a profile, click Revert to return to the original settings. If you want to delete a 
profile, select the profile and click the minus (-) button in the Details section.

Configuring a User Profile for a Personal Facebook 
Page Account

The following procedures assume you have created a Facebook account at 
https://www.facebook.com. User roles allow you to publish your packages automatically and without 
the requirement of review and approval.

https://www.facebook.com
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To set up a user profile for Facebook page:

1. Sign in to MediaCentral UX.

2. Select Home > User Settings. 

The User Settings dialog box opens.

3. In the Name pane, select Media Distribute.

4. Click the Publication Type menu and select FacebookPage.

5. Click the + (plus) button in the Details section.

A Facebook page profile named “New Profile” is created in the Details section.

6. Specify the required settings, using the parameter fields from your Facebook Apps Web page or 
from your Facebook profile in the MediaCentral UX System Settings layout (see “Configuring a 
Facebook Page Publication Account” on page 68).

- Profile Name (type a descriptive name for your profile)

- FB Profile ID

- FB Page ID

- Application ID

- Application Secret

- Application Secret
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- Access Token

- (Optional) Album ID

n You can specify the name of a Facebook album if you want to publish images directly to an album that 
you have created for your Facebook account.

- (Optional) Transcoding Profile

n You cannot publish video directly to Facebook unless you specify a transcoding profile.

7. (Optional) Click Get Expiration Date.

Media Distribute checks the expiration date of your access token and updates the entry in the 
Expiration Date field. This shows you how much time is left on your Facebook access token.

8. (Optional) Click Get Long-Term Token.

Media Distribute converts your access token, which often remains valid for a couple of hours, to 
a long-lived token. For more information on short-lived and long-lived tokens and their 
expiration periods, see your Facebook developer documentation.

9. Click Verify Profile Settings to validate the profile settings.

If your profile is valid, a message displays: “Profile configurations is valid.” If any settings are 
incorrect, a message displays and indicates which fields are incorrect. All invalid settings names 
change to red. 

10. Click Apply to save the profile. 

The profile displays in the Details section with the new information.

If you are editing a profile, click Revert to return to the original settings. If you want to delete a 
profile, select the profile and click the minus (-) button in the Details section.

Configuring a User Profile for a Personal Flickr 
Account

Before you can publish a package to Flickr from MediaCentral UX using Media Distribute, you must 
first set up an Flickr account to which you want to publish, and you must check the Flickr App 
Garden settings for your account.

The following procedures assume you have created an Flickr account at https://www.flickr.com, and 
that you have created your Flickr app. For information on creating apps for Flickr, see the Flickr 
documentation at https://www.flickr.com/services/api/.

https://www.flickr.com
https://www.flickr.com/services/api/
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To configure MediaCentral UX for your Flickr account:

1. Sign in to MediaCentral UX.

2. Select Home > User Settings. 

The User Settings dialog box opens.

3. In the Name pane, select Media Distribute.

4. Click the Publication Type menu and select Flickr.

5. Click the + (plus) button in the Details section.

An Flickr profile named “New Profile” is created in the Details section.

6. In the Profile Name text box, type a descriptive name for your profile.

7. Specify the required settings, using the parameter fields you copied from your Flickr app in the 
App Garden.

- API Key (from your app settings in the Flickr App Garden)

- API Secret (from your app settings in the Flickr App Garden)
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8. To get your Access Token and Access Secret, do the following:

a. Click Get Access Token.

The Get Access Token dialog box opens.

b. Click Request Token.

The Get Access Token dialog box updates and provides a URL link for the access token.
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c. Click the URL link in the Get Access Token dialog box.

The authorization Web page for your Flickr app opens.

d. Click OK, I’ll Authorize It.

The Flickr authorization Web page displays your authorization code.

e. Type your authorization code in the Verifier text box in the Get Access Token dialog box, 
and then click Exchange token.

The Get Access Token displays your Flickr app account data.

f. Click Save Token and Close.

The Get Access Token dialog box closes, and the following fields are automatically filled in 
the Flickr Profile:

- Access Token

- Access Secret

9. Click Transcoding Profile and select one of the available profiles.
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10. Click Verify Profile Settings to validate the profile settings.

If your profile is valid, a message displays: “Profile configurations is valid.” If any settings are 
incorrect, a message displays and indicates which fields are incorrect. All invalid settings names 
change to red. 

11. Click Apply to save the profile. 

The profile displays in the Details section with the new information.

If you are editing a profile, click Revert to return to the original settings. If you want to delete a 
profile, select the profile and click the minus (-) button in the Details section.

Configuring a User Profile for a Personal Twitter 
Account

The following procedures assume you have created a Twitter account at https://twitter.com.

To set up a user profile for Twitter:

1. Sign in to MediaCentral UX.

2. Select Home > User Settings. 

The User Settings dialog box opens.

3. In the Name pane, select Media Distribute.

4. Click the Publication Type menu and select Twitter.

5. Click the + (plus) button in the Details section.

A Twitter profile named “New Profile” is created in the Details section.

https://twitter.com/
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6. Specify the required settings, using the parameter fields from your Twitter application Web page 
or from your Twitter profile in the MediaCentral UX System Settings layout (see “Configuring a 
Twitter Publication Account” on page 59):

- Profile Name (type a descriptive name for your profile)

- Access Token

- Access Secret

- Consumer Key

- Consumer Secret

7. Click Verify Profile Settings to validate the profile settings.

If your profile is valid, a message displays: “Profile configurations is valid.” If any settings are 
incorrect, a message displays and indicates which fields are incorrect. All invalid settings names 
change to red. 

8. Click Apply to save the profile. 

The profile displays in the Details section with the new information.

If you are editing a profile, click Revert to return to the original settings. If you want to delete a 
profile, select the profile and click the minus (-) button in the Details section.

Configuring a User Profile for a Personal Vimeo V3 
Account

Before you can publish a package to Vimeo from MediaCentral UX using Media Distribute, you 
must first set up a Vimeo account to which you want to publish, and you must configure a Vimeo 
publication account.

The Vimeo V3 publication profile uses the V3 API for your Vimeo application. This allows you to 
employ the OAuth2 authentication protocol for your app.

The following procedures assume you have created a Vimeo account at https://vimeo.com/.

n The user interface for Vimeo might change without notice. The procedure below outlines the general 
steps to create the elements needed to configure Media Distribute. For more information on creating 
a Vimeo application, see your Vimeo account documentation.

https://vimeo.com/
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To configure MediaCentral UX for your Vimeo V3 application:

1. Sign in to MediaCentral UX.

2. Select Home > User Settings. 

The User Settings dialog box opens.

3. In the Name pane, select Media Distribute.

4. Click the Publication Type menu and select Vimeo V3.

5. Click the + (plus) button in the Details section.

A Vimeo V3 profile named “New Profile” is created in the Details section.

6. Specify the required settings, using the access token you copied from your Vimeo My Advanced 
API Apps Web page:

- Profile Name (type a descriptive name for your profile)

- Access Token

7. Click Transcoding Profile and select one of the available profiles.

8. Click Verify Profile Settings to validate the profile settings.

If your profile is valid, a message displays: “Profile configurations is valid.” If any settings are 
incorrect, a message displays and indicates which fields are incorrect. All invalid settings names 
change to red. 

9. Click Apply to save the profile. 

The profile displays in the Details section with the new information.

If you are editing a profile, click Revert to return to the original settings. If you want to delete a 
profile, select the profile and click the minus (-) button in the Details section.
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Configuring a User Profile for a Personal YouTube v3 
Account

Before you can publish a package to YouTube from MediaCentral UX using Media Distribute, you 
must first set up a Google account to manage the publication of your media package to YouTube, and 
you must configure a YouTube v3 publication account in MediaCentral UX.

The following procedures assume you have created a Google account at 
https://accounts.google.com/.

n The user interface for Google accounts might change without notice. The procedure below outlines 
the general steps to create the elements needed to configure Media Distribute. For more information 
on creating and managing a Google or YouTube application, see your Google developer account 
documentation.

If you use a YouTube profile created before April 2015, you can follow the procedures described in 
“Configuring a YouTube v3 Publication Account” on page 84. For new profiles, you can use the Avid 
Media Distribute Integration application to generate the necessary access token and refresh token. 
MediaCentral UX also supplies the following default parameter values when it creates a new 
YouTube v3 profile so it can use the Avid application: 

• Client Id

• Client Secret

• Scopes

• Redirect URI

n To use the Avid Media Distribute Integration application to generate default values for your YouTube 
v3 account, you must be logged in to the Google account you use for publishing videos from Media 
Distribute.

If you want to create your own YouTube application, you can replace the profile parameter values 
with those copied from your YouTube application. You need to generate the Client ID and Client 
Secret from the OAuth 2.0 credentials in the Credentials Web page in the APIs and auth section of 
your application in the Google Developers Console. You also need to supply the values for the 
Scopes and Redirect URI parameters. For more information, see the Google Developers 
documentation.

To configure MediaCentral UX for your YouTube v3 account:

1. Log on to your Google account at https://accounts.google.com/.

2. If you have never used this account to upload a video, do the following to create a YouTube 
channel:

a. In your browser, navigate to https://www.youtube.com/my_videos.

b. Create a new channel. For information creating a new YouTube channel, see the YouTube 
online help.

3. Sign in to MediaCentral UX.

https://accounts.google.com/
https://accounts.google.com/
https://www.youtube.com/my_videos
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4. Select Home > User Settings. 

The User Settings dialog box opens.

5. In the Name pane, select Media Distribute.

6. Click the Publication Type menu and select YouTube v3.

7. Click the + (plus) button in the Details section.

A YouTube v3 profile named “New Profile” is created in the Details section, and the following 
parameter fields are automatically filled by default:

- Client ID

- Client Secret

- Scopes

- Redirect URI

8. Specify a Profile Name by typing a descriptive name for your profile.

9. Click the Privacy Settings menu and select one of the following options:

t Public — Everyone can view your published videos.

t Unlisted — Only those with whom you share a URL link can view your published video. 

t Private — Videos cannot be viewed by the public.
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10. Click Get Tokens.

The Avid Media Distribute Integration application opens a Web page asking permission to 
manage your YouTube account. This allows the application to generate the necessary access 
tokens so you can publish videos to your YouTube account.

n If you already received the access and refresh tokens, clicking Get Tokens does not supply you with 
new tokens. You need to click Revoke Tokens, and then click Get Tokens.

11. Click Allow.

The Avid Media Distribute Integration application generates the access tokens and displays them 
on the application Web page.

12. Copy the Access Token value to the parameter field for Access Token in your MediaCentral 
YouTube v3 profile.

13. Copy the Refresh Token value to the parameter field for Refresh Token in your MediaCentral 
YouTube v3 profile.

14. Click Transcoding Profile and select one of the available profiles.

15. Click Verify Profile Settings to validate the profile settings.

If your profile is valid, a message displays: “Profile configurations is valid.” If any settings are 
incorrect, a message displays and indicates which fields are incorrect. All invalid settings names 
change to red. 

16. Click Apply to save the profile. 

The profile displays in the Details section with the new information.

If you are editing a profile, click Revert to return to the original settings. If you want to delete a 
profile, select the profile and click the minus (-) button in the Details section.
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Media Distribute Pre-Flight Checklist  

Component Notes

MCS Server

Server name

IP Address

Administrator User / Password

MediaCentral | UX Version Must be MediaCentral UX 2.2.

Media Distribute

First Install, Reinstall, or Update?

Twitter Capture data below for each independent Twitter endpoint

Site URL Public URL for the Twitter application

Profile Name Descriptive name for the Twitter Profile

Profile Type User Account or House Account

Access Token

Access Token Secret

Consumer Key

Consumer Secret

Facebook Capture data below for each independent Facebook endpoint

Site URL

Profile Name

Profile Type User Account or House Account

Facebook Profile ID

Application ID

Application Secret

Access Token

Album ID
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Facebook Page Capture data below for each independent Facebook endpoint

Site URL

Profile Name

Profile Type User Account or House Account

FB Profile ID

FB Page ID

Application ID

Application Secret

Access Token

Album ID

Send to Playback Capture data below for each independent STP endpoint

Profile Name

Target VCID

Audio Direct, Stereo, or Mono

Audio Bit Depth 16 or 24

Audio Target Sample Rate 32000, 44100, 48000, or 96000

Shared ISIS Workspace The STP service requires this Avid shared storage workspace to store 
video prior to delivery to the transcode service. Type the name of a valid 
shared storage workspace.

Transfer Manager Host You can use the values from your Transfer Manager configuration. For 
more information, see the Interplay | Transfer Setup and User's Guide.

Transfer Manager Destination 
Profile

Transfer Manager Profile Type Frame, IFrameAMS, LongGoP, or LongGoPAMS

Mixing Down FTP Host Type the FTP host name.

Mixing Down FTP Path Type the path to the FTP destination where MXF output is staged for 
transcode.

Mixing Down FTP Username Type the user name for your FTP service credentials.

Mixing Down FTP Password Type the password for your FTP service credentials.

Vimeo Capture data below for each independent Vimeo endpoint

Profile Name

Access Token

Access Secret

Media Distribute Pre-Flight Checklist  

Component Notes
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Consumer Key

Consumer Secret

Transcoding Profile Profile obtained from Transcoder configuration.

Vimeo V3 Capture data below for each independent Vimeo V3 endpoint

Profile Name

Access Token

Transcoding Profile Profile obtained from Transcoder configuration.

YouTube Capture data below for each independent YouTube endpoint

Profile Name

Application Name

Developer Key

User Name

Password

Transcoding Profile Profile obtained from Transcoder configuration.

YouTube v3 Capture data below for each independent YouTube v3 endpoint

Profile Name

Client Id Auto-filled with default values. You can change these if you use your own 
Google application.

Client Secret Auto-filled with default values. You can change these if you use your own 
Google application.

Access token Supplied by the Avid Media Distribute Integration application.

Refresh token Supplied by the Avid Media Distribute Integration application.

Scopes Auto-filled with default values. You can change these if you use your own 
Google application.

Redirect URI Auto-filled with default values. You can change these if you use your own 
Google application.

Transcoding Profile Profile obtained from Transcoder configuration.

Brightcove

Profile Name

Read Token

Write Token

Transcoding Profile Profile obtained from Transcoder configuration.

Media Distribute Pre-Flight Checklist  

Component Notes
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Kaltura

Profile Name

Partner ID

User ID

User Secret

Administrator Secret

Transcoding Profile Profile obtained from Transcoder configuration.

Ooyala

Profile Name

API Key

API Secret

Transcoding Profile Profile obtained from Transcoder configuration.

Flickr

Profile Name

API Key

API Secret

Access Token

Access Secret

Transcoding Profile Profile obtained from Transcoder configuration.

Atex Polopoly

Profile Name

Server Name http:// (the name of your Polopoly host)

User Name Your Polopoly login name

Password Your Polopoly login password

Service Address Address of the Polopoly REST service

External ID

OVP Profile

WorldNow

Profile Name

User Name Your WorldNow login name

Password Your WorldNow login password

Media Distribute Pre-Flight Checklist  
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Affiliate Number From your WorldNow account information

Producer Host From your WorldNow account information

FTP Ingest Hostname From your WorldNow account information

FTP Username From your WorldNow account information

FTP Password From your WorldNow account information

Transcoding Profile Profile obtained from Transcoder configuration.

WordPress

Profile Name

Blog ID From your WordPress configuration information

Username Your WordPress administrator login name

Password Your WordPress administrator login password

Host’s API URL From your WordPress configuration information

Transcoding Profile Profile obtained from Transcoder configuration.

Amazon S3

Profile Name

Access Key

Secret Access Key

Endpoint

Bucket Name

Transcoding Profile Profile obtained from Transcoder configuration.

Bitly

Profile Name

Login

API Key

Transcoding

Transcode share hostname ftp://hostname. For more information, see “Configuring the Video 
Transcoding Host” on page 33.

Telestream Vantage Capture data below for each independent transcoder profile

Profile Name

Workflow ID From your Vantage workflow configuration

Host Name
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FTP User Name From Video Transcoding Configuration

FTP Password From Video Transcoding Configuration

FTP Transcode/In Path For incoming files, from your video host transcoding configuration

FTP Transcode/Out Path For outgoing files, from your video host transcoding configuration

File Share In Path From your video host transcoding configuration

Harmonic ProMedia Carbon Capture data below for each independent transcoder profile

Profile Name

Workflow ID From your CarbonCoder profile

Host Name Your CarbonCoder hostname

FTP User Name From your video host transcoding configuration

FTP Password From your video host transcoding configuration

FTP Transcode/In Path For incoming files, from your video host transcoding configuration

FTP Transcode/Out Path For outgoing files, from your video host transcoding configuration

File Share In Path From your video host transcoding configuration

RadiantGrid Capture data below for each independent RadiantGrid transcoding profile

Profile Name

RadiantGrid User Name From your RadiantGrid profile

RadiantGrid Password From your RadiantGrid profile

Transcoding Profile Name The profile name listed on the Workflow > Transcode Web page of your 
RadiantGrid configuration)

Host Name The RadiantGrid server hostname

FTP User Name From your video host transcoding configuration

FTP Password From your video host transcoding configuration

FTP Transcode/In Path For incoming files, from your video host transcoding configuration

FTP Transcode/Out Path For outgoing files, from your video host transcoding configuration

File Share In Path From your video host transcoding configuration

thePlatform Capture data below for each independent thePlatform profile

Profile Name

Username Your thePlatform login name

Password Your thePlatform login password

Transcoding Profile Profile obtained from Transcoder configuration.

Media Distribute Pre-Flight Checklist  
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Upload Servers (Optional) From your thePlatform configuration.

FTP Ingest Server (Optioinal) From your FTP configuration.

Generic CMS

Profile Name

Provider ID The provider ID identifies your CMS and is included in the XML file 
created by the profile.

FTP Hostname Your CMS server hostname

FTP Path From your video host transcoding configuration

FTP Username From your video host transcoding configuration

FTP Password From your video host transcoding configuration

Transcoding Profile Profile obtained from Transcoder configuration.

OVP Profile Profile obtained when you configure your online video provider settings

Archive Sends image and video metadata to the FTP host in a single compressed 
ZIP file

Image FTP Host FTP server hostname for delivery of image files and metadata

Image FTP Path Path on your FTP server that you want to use for delivery of image files 
and metadata

Image FTP Login Account name used to log in to your FTP server

Image FTP Password Password for your FTP server account

Video FTP Host FTP server hostname for delivery of video files and metadata

Video FTP Path Path on your FTP server that you want to use for delivery of video files 
and metadata

Video FTP Login Account name used to log in to your FTP server

Video FTP Password Password for your FTP server account

Generic CMS Extended

Profile Name

Auto Approve Allows the publishing process to start as soon as the package is saved.

Media Groups Use this field for a user-defined property by typing a text string with each 
value separated by a semicolon.

FTP Hostname Your CMS server hostname

FTP Path From your video host transcoding configuration

FTP Username From your video host transcoding configuration

FTP Password From your video host transcoding configuration

Media Distribute Pre-Flight Checklist  

Component Notes
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Transcoding Profile Profile obtained from Transcoder configuration.

OVP Profile Profile obtained when you configure your online video provider settings

Archive Sends image and video metadata to the FTP host in a single compressed 
ZIP file

Image FTP Host FTP server hostname for delivery of image files and metadata

Image FTP Path Path on your FTP server that you want to use for delivery of image files 
and metadata

Image FTP Login Account name used to log in to your FTP server

Image FTP Password Password for your FTP server account

Video FTP Host FTP server hostname for delivery of video files and metadata

Video FTP Path Path on your FTP server that you want to use for delivery of video files 
and metadata

Video FTP Login Account name used to log in to your FTP server

Video FTP Password Password for your FTP server account

Metadata XSL Option to type or copy and paste the content of a metadata XSL file into 
the text box to allow for metadata transformation and mapping of the 
attributes

Generic OVP

Profile Name

FTP Hostname Your FTP server hostname

FTP Path From your video host transcoding configuration

FTP Username From your video host transcoding configuration

FTP Password From your video host transcoding configuration

Transcoding Profile Profile obtained from Transcoder configuration.

NoOpTranscoder

Profile Name

Media Distribute Pre-Flight Checklist  

Component Notes



B Working with Media | Distribute Logs

Media Distribute provides you with logging capabilities to help you troubleshoot problems with your 
installation. Working with the Media Distribute debug logging level can give you more information 
to resolve issues.

Enabling the debug logging level increases the amount of logging information saved to the system. 
You can configure Media Distribute logging to adjust the maximum size of the log files or the 
maximum number of files saved on the system.

n By default, Media Distribute sets the logging level to INFO.

When you change the logging level, the changes are applied immediately to your system, and you do 
not need to restart any Media Distribute services.

To enable the debug logging level:

1. Open a terminal window and log in as root to the server where you installed Media Distribute.

2. Navigate to the directory containing the logging configuration file: 

cd /usr/share/apache-servicemix/etc

3. Using the Linux text editor, vi, open the org.ops4j.pax.logging.cfg file for editing:

vi org.ops4j.pax.logging.cfg

4. Locate the following line, and then navigate using the arrow keys to the INFO parameter:

log4j.rootLogger=INFO, out, osgi:VmLogAppender

5. Type i (lower case “i”) to enter insert mode, and then use the arrow keys and backspace to erase 
INFO and replace it with DEBUG.

log4j.rootLogger=DEBUG, out, osgi:VmLogAppender

n To disable the debug logging level, replace DEBUG with INFO.

6. Press the Escape key to return to command mode, then type :wq and press Return to write and 
quit the text editor.

The change is applied immediately. You do not need to restart any Media Distribute services.

To change the default log file size:

1. Open a terminal window and log in as root to the server where you installed Media Distribute.

2. Navigate to the directory containing the logging configuration file: 

cd /usr/share/apache-servicemix/etc

3. Using the Linux text editor, vi, open the org.ops4j.pax.logging.cfg file for editing:

vi org.ops4j.pax.logging.cfg

4. Locate the following line, and then navigate using the arrow keys to the 10MB parameter:

log4j.appender.out.maxFileSize=10MB
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5. Type i (lower case “i”) to enter insert mode, and then use the arrow keys and backspace to erase 
10MB and replace it with the appropriate maximum file size.

6. Press the Escape key to return to command mode, then type :wq and press Return to write and 
quit the text editor.

The change is applied immediately. You do not need to restart any Media Distribute services.

To change the number of log files saved by the system:

1. Open a terminal window and log in as root to the server where you installed Media Distribute.

2. Navigate to the directory containing the logging configuration file: 

cd /usr/share/apache-servicemix/etc

3. Using the Linux text editor, vi, open the org.ops4j.pax.logging.cfg file for editing:

vi org.ops4j.pax.logging.cfg

4. Locate the following line, and then navigate using the arrow keys to the 100 parameter:

log4j.appender.out.maxBackupIndex=100

5. Type i (lower case “i”) to enter insert mode, and then use the arrow keys and backspace to erase 
100 and replace it with the maximum number of files to be saved on the system.

6. Press the Escape key to return to command mode, then type :wq and press Return to write and 
quit the text editor.

The change is applied immediately. You do not need to restart any Media Distribute services.



C Modifying the Transcoder Monitoring 
Interval

Media Distribute uses a default monitoring interval of one minute (60000 ms) for transcode services 
(Mixing Down, Mixed Down, and Transcoding). These various transcode processes display in the 
status window within the Media Distribute Packages pane for each specific package that requires 
video transcoding.

After successful configuration and operation of an Media Distribute instance, you can change these 
default monitoring intervals by editing an Media Distribute configuration file.

To modify the transcoder monitoring interval:

1. Open a session on the Media Distribute server.

2. Using Linux commands, navigate to the directory containing the Media Distribute configuration 
file: /etc/apache-servicemix/mpd/com.avid.mpd.cfg.

3. Using the Linux text editor, vi, open the com.avid.mpd.cfg file for editing:

vi com.avid.mpd.cfg

4. Type i (lower case “i”) to enter insert mode, and then use the arrow keys to position the cursor at 
the appropriate location.

5. Edit the monitorMixingdownInterval, monitorMixeddownInterval, and 
monitorTranscodingJobsInterval values (the default is 60000). 

c Do not modify the monitorLockedEntitiesInterval or lockedEntityTimeToLive values.
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Avid recommends that you do not set the interval below 10000 (10 seconds).Setting the interval 
to a smaller number might improve the response time for the transcode operation, but this change 
can also increase the amount of chatter over the service bus.

6. Press the colon key (:) to return to command mode, then type wq to write and quit the text editor, 
and press Return.

7. Exit the session.



D Modifying the Settings for Interlaced 
Graphics

When you attach an image to your media package by clicking the Load from Player button, Media 
Distribute takes the image from the frame selected in the Media pane. If your video uses an interlaced 
format, this can cause the attached image to display interlacing effects which can degrade the quality 
of the image. You can set Media Distribute to deinterlace the graphics file it receives from the Media 
viewer by editing the transcoding configuration file.

To change the settings for interlaced graphics:

1. Open a terminal window and log in as root to the server where you installed Media Distribute.

2. Navigate to the directory containing the transcoding configuration file: 

cd /usr/share/apache-servicemix/etc/mpd

3. Using the Linux text editor, vi, open the transcoding.cfg file for editing:

vi transcoding.cfg

4. Locate the following line, and then navigate using the arrow keys to the deinterlacing parameter:

image.processing.deinterlacing={true,false}

5. Type i (lower case “i”) to enter insert mode, and then use the arrow keys and backspace to erase 
the bracketed options (including the brackets) and then type true.

image.processing.deinterlacing=true

6. Press the Escape key to return to command mode, then type :wq and press Return to write and 
quit the text editor.

7. Restart the Media Distribute services on the server or on all cluster nodes by typing the 
following:

service avid-mpd clean-restart



E Sample XSL for the Generic CMS Extended 
Profile

The Generic CMS Extended profile provides you with the option of including custom categories for 
publishing your media package to a CMS. You can specify these categories in an extensible 
stylesheet language (XSL) file. Using the XSL file, you can remap metadata using XSL 
transformations into the attribute names or tags for which your CMS is configured. For example, you 
can extract a file name category value from the Video-URL.

The following is an example of a custom XSL file used to create categories for Media Distribute 
using the Generic CMS Extended profile. This example is provided for descriptive purposes only. 
You must create your own XSL file if you want to use this feature of Media Distribute.

<xsl:stylesheetversion="1.0"xmlns:xsl="http://www.w3.org/1999/XSL/Transform">
<xsl:templatematch="/webStory">

<assetRecord>
<headline>

<xsl:value-ofselect="title"/>
</headline>
<summary>

<xsl:value-ofselect="lead"/>
</summary>
<body>

<xsl:value-ofselect="body"/>
</body>
<embeddedImage>

<xsl:value-ofselect="attachedImages/image/url"/>
</embeddedImage>
<embeddedVideo>

<xsl:value-ofselect="attachedVideos/video/url"/>
</embeddedVideo>
<mediaGroup>

<xsl:value-ofselect="metadata/entry[string[1] = 
'GCE_MediaGroup']/string[2]"/>

</mediaGroup>
<publishTime>

<xsl:value-ofselect="metadata/entry[string[1] = 
'GCE_PublishTime']/string[2]"/>

</publishTime>
<fileName>

<xsl:call-templatename="fileName">
<xsl:with-paramname="path"select="attachedVideos/video/

url"/>
</xsl:call-template>

</fileName>
<userName>

<xsl:value-ofselect="metadata/entry[string[1] = 
'userLogonName']/string[2]"/>

</userName>
<approverName>
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<xsl:value-ofselect="metadata/entry[string[1] = 
'userLogonName']/string[2]"/>

</approverName>
<userFullName>

<xsl:value-ofselect="metadata/entry[string[1] = 
'userFullName']/string[2]"/>

</userFullName>
<email>

<xsl:value-ofselect="metadata/entry[string[1] = 'userMail']/
string[2]"/>

</email>
<clip>

<createdDate>
<xsl:value-ofselect="metadata/entry[string[1] = 

'com.avid.workgroup.Property.System.CreationDate']/string[2]"/>
</createdDate>
<source>

<xsl:value-ofselect="attachedVideos/video/metadata/
entry[string[1] = 'mobId']/string[2]"/>

</source>
<duration>

<xsl:value-ofselect="metadata/entry[string[1] = 
'com.avid.workgroup.Property.System.Duration']/string[2]"/>

</duration>
<startSourceTimecode>

<xsl:value-ofselect="metadata/entry[string[1] = 
'com.avid.workgroup.Property.System.Start']/string[2]"/>

</startSourceTimecode>
<endSourceTimecode>

<xsl:value-ofselect="metadata/entry[string[1] = 
'com.avid.workgroup.Property.System.End']/string[2]"/>

</endSourceTimecode>
<fps>

<xsl:value-ofselect="metadata/entry[string[1] = 
'com.avid.workgroup.Property.System.FPS']/string[2]"/>

</fps>
<title>

<xsl:value-ofselect="title"/>
</title>
<description>

<xsl:value-ofselect="lead"/>
</description>
<metadata>

<xsl:for-eachselect="metadata/entry">
<metadataEntry>

<id>
<xsl:value-ofselect="string[1]"/>

</id>
<value>

<xsl:value-ofselect="string[2]"/>
</value>

</metadataEntry>
</xsl:for-each>

</metadata>
</clip>

</assetRecord>
</xsl:template>
<xsl:templatename="fileName">

<xsl:paramname="path"/>
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<xsl:choose>
<xsl:whentest="contains($path,'\')">

<xsl:call-templatename="fileName">
<xsl:with-paramname="path"select="substring-

after($path,'\')"/>
</xsl:call-template>

</xsl:when>
<xsl:whentest="contains($path,'/')">

<xsl:call-templatename="fileName">
<xsl:with-paramname="path"select="substring-after($path,'/

')"/>
</xsl:call-template>

</xsl:when>
<xsl:otherwise>

<xsl:value-ofselect="$path"/>
</xsl:otherwise>

</xsl:choose>
</xsl:template>

</xsl:stylesheet>



F Custom Configuration for Avid Publish 
Services

Starting with Media Distribute v2.7, some publish services are installed to connect to the ACS bus 
API. You can install these services in a different location or a different environment if you need to 
increase the performance of services in hight-load systems or if you need to have additional instances 
of the services for reliability.

Installing Avid Publish Services Manually
All Avid Publish Services are installed as part of the Media Distribute installation. However, if you 
need to install the services in a location different from the default location, you can install the 
services from the Packages folder in the Media Distribute installation directory. You must install the 
services on all nodes of a cluster configuration.

n You must install Avid MediaCentral Platform Services (MCS) before installing the Avid Publish 
Services in a location different from the default location. 

To install Avid Publish Services manually:

1. Using Linux commands, navigate to the directory containing the Media Distribute services 
installation files: cd Media_Distribute_<version>_Build_<xx>_Linux/Packages.

2. Install the appropriate service by typing the following command: yum install <service-
rpm>

For example: yum install avid-publish-facebook-1.0.0-
11.20160606.0946.x86_64.rpm

3. After you have installed your services, start each service by typing the following command: 
service <service-name> start

For example: service avid-publish-facebook start

4. If necessary, configure the publish services configuration file for each service. For information 
on editing the configuration files, see “Configuring the Avid Publish Services” on page 151.

Configuring the Avid Publish Services
If you install Media Distribute using the installation script, the following Avid Publish Services 
install automatically.

• avid-publish--amazon-s3.cfg

• avid-publish-facebook.cfg

• avid-publish-flickr.cfg

• avid-publish-twitter.cfg

• avid-publish-vimeo.cfg
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• avid-publish-youtube.cfg

• avid-publish-stp.cfg

• avid-publish-vantage.cfg

• avid-publish-mam.cfg

If you install the Media Distribute on a cluster, you can manually modify the Avid Publish Services 
configuration files for your configuration. You must configure the services on the master node and 
non-master nodes of your configuration.

n If your MediaCentral installation is configured on a single node, the Avid Publish Services require no 
additional configuration steps.

To modify the Avid Publish Services configuration files:

1. Using Linux commands, navigate to the directory containing the Avid Publish Services 
configuration files: cd /etc/sysconfig.

The directory contains configuration files for each of the publish services:

- avid-publish--amazon-s3.cfg

- avid-publish-facebook.cfg

- avid-publish-flickr.cfg

- avid-publish-twitter.cfg

- avid-publish-vimeo.cfg

- avid-publish-youtube.cfg

- avid-publish-stp.cfg

- avid-publish-vantage.cfg

- avid-publish-mam.cfg

2. Using the Linux text editor, vi, open the configuration file for each publish service your 
configuration requires and do the following:

a. If you want to configure the publish service to connect to a not-local ACS Gateway, locate 
the following line, and then navigate using the arrow keys and place the cursor on top of the 
# (comment indicator):

# export ACS_GATEWAY_HOST=127.0.0.1

b. Type i (lower case “i”) to enter insert mode, and then use the arrow keys and backspace to 
erase the # (comment indicator).

c. Delete the IP value at the end of the line, and then replace it by typing the ACS Gateway 
Host IP address — for example, export ACS_GATEWAY_HOST=192.168.1.2

d. If your gateway connection uses a port other than the default port 9500, locate the following 
line, and then navigate using the arrow keys and place the cursor on top of the # (comment 
indicator):

# export ACS_GATEWAY_PORT=9500

e. Delete the port value at the end of the line, and then replace it by typing your ACS Gateway 
port — for example, export ACS_GATEWAY_PORT=9600

f. Press the Escape key to return to command mode, then type :wq and press Return to write 
and quit the text editor.
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3. If you specified a new ACS Gateway Host, do the following to edit the ACS Gateway 
configuration:

a. Using the Linux text editor, vi, open the ACS Gateway configuration file for editing:

vi /etc/sysconfig/avid-acs-gateway.cfg

b. Locate the following line: 

ACS_SECURITY_FULL_TRUST_IPV4_MASK_LIST

c. Change the default value, “127.0.0.0/25;”, to the IP address of your ACS Gateway 
Host — for example, “192.168.1.2;”.

n For more information on configuring the ACS Gateway, see your MCS administrator.

4. When you have finished editing the configuration files for each service used in your 
configuration and the ACS Gateway configuration file, restart each service by typing the 
following command: service <service-name> restart

For example: service avid-publish-facebook restart



G Deleting Packages from Packages Pane

When you publish multiple packages to multiple platforms, the Packages pane can expand to more 
than one page, listing all packages that have been submitted. You can delete the published packages 
from the Packages pane, but you can only delete one page at a time.

Media Distribute provides a script that can be used by your MediaCentral administrator to delete all 
published packages from all pages in the Packages pane.

n In a cluster configuration, you must run script on the master node.

You can automate the packages deletion by configuring a cron job for your system.

To delete all packages from all pages in the Packages pane:

1. Navigate to the following Web site on the Avid Knowledge Base: http://avid.force.com/pkb/
articles/en_US/how_to/How-to-remove-all-pages-from-the-Media-Distribute-Packages.

2. Download the attached mpd_packages_manager_<version_number>.zip file.

3. Copy the compressed zip file to your MediaCentral single server or to the master node in a 
cluster configuration.

4. Type the following command to unzip the file.

unzip mpd_package_manager_<version_number>.zip

5. Type the following command to add the execution mode to the uncompressed script:

chmod u+x <script_location>/mpd_delete_packages.sh

6. Type one of the following commands to delete all packages form the Packages pane:

t /<script_location>/mpd_delete_packages.sh <parameters>

t cd /<script_location

./mpd_delete_packages.sh [parameters]

The following table describes the parameter options:

Option Description

-db <arg> Database host. The default value is localhost. In a cluster configuration, use this 
parameter to specify the cluster IP address.

-?,--help Print this message.

-n <arg> Delete all packages older than n weeks. Default number of weeks is 3.

-s,--silent Silent mode.

http://avid.force.com/pkb/articles/en_US/how_to/How-to-remove-all-pages-from-the-Media-Distribute-Packages.
http://avid.force.com/pkb/articles/en_US/how_to/How-to-remove-all-pages-from-the-Media-Distribute-Packages.
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To set up the script to run as a cron job:

1. To edit or create a crontab (cron table) file, type the following command at the UNIX / Linux 
shell prompt:

# crontab -e

The text editor vi opens so you can add entries for the crontab.

2. If necessary, type *o to add a line in the crontab.

3. Specify the appropriate schedule for the cron job: 

* * * * * <command to be executed>

The asterisks (*) indicate the following parameters for the cron job:

n For information on cron syntax and formats, see the cron documentation.

4. (Optional) Type *o to add a line in the crontab so you can set the MAILTO value to send the 
script output to the appropriate individual.

n Cron looks at the MAILTO parameter value to determine if mail is to be sent as a result of running 
the commands in the crontab:

- If MAILTO is defined (and non-empty), mail is sent to the specified user.

- If MAILTO is defined but empty ('MAILTO=””), no mail is sent,

- If MAILTO is not defined, mail is sent to the owner of the crontab.

For example, to specify and e-mail is sent to Jane Doe, use the following command:

MAILTO=jane.doe@avid.com

5. Type one of the following commands to set the job to execute:

t cd <script_location> && <script_location>/mpd_delete_packages.sh -s

t cd <script_location> && <script_location>/mpd_delete_packages.sh -s -db 
<database_host>

-s tells the script to delete all found packages silently.

-db must be used if PostgreSQL database is located on the remote machine — for example, in a 
cluster configuration.

For example, to run the script at 1130 PM every night, use the following command:

30 23 * * * cd /opt/avid/package_manager && /opt/avid/package_manager/
mpd_delete_packages.sh -s

Parameter Range of Allowed Values

Minute 0 - 59

Hour 0 - 23

Day of month 1 - 31

Month 1 - 12

Day of week 0 - 7 (0 or 7 is Sunday)

Using an asterisk (*) as a parameter indicates a range of first to last
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6. Type the following command to ensure logs are created in /var/log/avid/mpd_package_manager:

cd <script_location> && <script_location>/mpd_delete_packages.sh -s -db 
<database_host> -n <number_of_weeks>

7. Type :wq and then press Return to save the crontab file and exit the text editor.
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